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Compliance Information

For Customers in the European Union
This equipment displays the CE mark to indicate conformance to the 
following legislation:

For Customers in the U.S.A.
This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 1) this device may not cause harmful 
interference, and 2) this device must accept any interference received, 
including interference that may cause undesired operation.

Warning

Changes or modifications to this unit not expressly approved by the 
party responsible for compliance could void the user’s authority to 
operate the equipment.

This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide responsible protection against harmful 
interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio 

EN55022:2006 + A1:2007 Class A Emissions Standard for industrial environments
EN61000-6-4 2007 Generic Emissions Standard for Heavy Industrial 

Environments
EN61000-3-2 2006 Harmonic Current Fluctuations 
EN61000-3-3 2008 Voltage Fluctuation and Flicker 

EN61000-6-2 2005 Immunity Characteristics for Industrial Environ-
ments

Following the provisions of EU EMC Directive 2004/108/EC
EC Low Voltage Directive 2006/95/EEC
Essential health and safety requirements relating to electrical equipment designed for use within 
certain voltage limits.
IEC 60950-1:2001
Safety requirements for information technology equipment including electrical business equipment.
EN 60529:1991
Degrees of protection provided by enclosures (IP code).
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communications. Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Shielded cables must be used with this unit to ensure compliance with 
Class A FCC limits.

The user may find the following booklet prepared by the Federal 
Communications Commission helpful: How to Identify and Resolve 
Radio-TV Interference Problems. This booklet is available from the U.S. 
Government Printing Office, Washington, DC 20402, Stock No. 004-00-
00345-4.

This equipment has been tested and certified for compliance with U.S. 
regulations regarding safety and electrical emissions by: 

Electromagnetic Testing Services Limited

Pratts Fields

Lubberhedges Lane

Stebbing, Dunmow

Essex, CM6 3BT

England, UK

This equipment has been investigated by Underwriters Laboratories Inc. 
in accordance with the standard for safety: UL 60950-1: Safety of 
information technology equipment first edition. Subject 2178 marking and 
coding equipment, electronics.

Report reference E252185.

For Customers in Canada
This digital apparatus does not exceed the Class A limits for radio noise 
emissions from digital apparatus set out in the Radio Interference 
Regulations of the Canadian Department of Communications.

This equipment has been tested and certified for compliance with 
Canadian regulations regarding safety and electrical emissions by:

Electromagnetic Testing Services Limited

Pratts Fields

Lubberhedges Lane

Stebbing, Dunmow

Essex, CM6 3BT

England, UK
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This equipment has been investigated by Underwriters Laboratories 
Incorporated in accordance with the standard for safety: CAN/CSA C22.2 
No. 60950-1-03. Safety of information technology equipment. Subject 2178 
marking and coding equipment, electronics.

Report reference E252185.

Pour la clientèle du Canada
Le present appareil numerique n’emet pas de bruits radioelectriques 
depassant les limites applicales aux appareils numerique de las class A 
prescrites dans le Reglement sur le brouillage radioelectrique edicte par le 
ministere des Communications du Canada.

Cet équipement est certifié CSA.

This equipment has been investigated by Underwriters Laboratories 
Incorporated in accordance with the standard for safety: CAN/CSA C22.2 
No. 60950-1-03. Safety of information technology equipment. Subject 2178 
marking and coding equipment, electronics.

Report reference E252185.

Warning

This product is not intended for use in the immediate/direct visual 
field of the display work place. To avoid disturbing reflections on 
the display work place, this product shall not be placed in the 
immediate/direct field of vision.



Rev AA     iv

Customer Support and Training

Contact Information
If you have any questions or need assistance, please contact Videojet 
Technologies Inc. at 1-800-843-3610 (for all customers within the United 
States). Outside the U.S., customers should contact their Videojet 
Technologies Inc. distributor or subsidiary for assistance.

Videojet Technologies Inc.

1500 Mittel Boulevard

Wood Dale, IL 60191-1073 U.S.A.

Phone: 1-800-843-3610

Fax: 1-800-582-1343

International Fax: 630-616-3629

Web: www.videojet.com

Service Program
About Total Source Commitment
Total Source® TOTAL SERVICE PLUS RELIABILITY, is the Videojet 
Technologies Inc. commitment to provide you - our customer - the 
complete service you deserve.

The Total Source Commitment
The Videojet Total Source® Service Program is an integral part of our 
business in providing marks, codes, and images where, when, and how 
often customers specify for packages, products, or printed materials. Our 
commitment includes:

• Applications support.

• Installation services.

• Maintenance training.

• Customer response center.

• Technical support.

• Field service.

• Extended hours phone assistance.

• Parts and supplies.

• Repair service.
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Customer Training
If you wish to perform your own service and maintenance on the printer, 
Videojet Technologies Inc. highly recommends you complete a Customer 
Training Course on the printer.

Note: The manuals are intended to be supplements to (and not replacements for) 
Videojet Technologies Inc. Customer Training.

For more information on Videojet Technologies Inc. Customer Training 
Courses, call 1-800-843-3610 (within the United States only). Outside the 
U.S., customer should contact a Videojet subsidiary office or the local 
Videojet distributor for further information.
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1Introduction

Videojet 1520 Excel Printer
This printer is a continuous ink jet printer that can print fixed and variable codes at 
elevated line speeds on consumer and industrial products. The printer delivers 
superior uptime, excellent print quality, and ease of use to the users.

About the Manual
This Operator Manual is written for the every day user of the printer. The 
Operator Manual helps the user to understand the different parts and different 
printing operations of the printer.

Related Publications
The following manual is available for reference:

Videojet 1520 Excel Service Manual, Part Number: 462274.

Language Codes
When you order these manuals, make sure to add the 2-digit language code at the 
end of the part number. For example, the spanish version of the operator manual is 
part number 462270-04. Table 1-1 on page 1-2 shows the list of language codes 
that you can use to identify the translated versions of this manual.

Note: The availability of the Operator Manual is indicated by an asterisk (*). 
Availability of the Service Manual is indicated by a plus sign (+). For more 
information, contact the Videojet distributor or subsidiary.
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Content Presentation
This Operator Manual contains different types of information like, safety 
guidelines, additional notes, user interface (UI) terminology and so on. To help 

Code Language Availability (see 
note)

01 English (US) * +

02 French *

03 German *

04 Spanish *

05 Portuguese Brazilian *

08 Italian *

09 Dutch *

11 Arabic *

15 Norwegian *

16 Finnish *

17 Swedish *

18 Danish *

19 Greek *

20 Hebrew *

21 English (UK) * +

23 Polish *

24 Turkish *

25 Czech *

26 Hungarian *

33 Vietnamese *

34 Bulgarian *

44 Romanian *

45 Macedonian *

46 Serbian *

Table 1-1: List of Language Codes 
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you identify the different types of information, different writing styles are used in 
this manual. This section describes these writing styles.

Positional References
Positions and directions like left, right, front, rear, to the right and to the left are 
with respect to the printer when you see from the front.

Units of Measurement
This manual uses metric units of measurement. The equivalent English measures 
are included in parenthesis. For example, 240 mm (9.44 inches).

Safety Information
The safety information includes warning and caution statements.

Warning
The warning statements indicate hazards or unsafe practices that can cause severe 
personal injury or death. For example:

Warning

PERSONAL INJURY. The cleaning solution is poisonous if taken 
internally. Do not drink. Seek medical attention immediately if ingested.

Caution
The caution statements indicate hazards or unsafe practices that can cause damage 
to the equipment. For example:

Caution

EQUIPMENT DAMAGE. Do not fit or remove any connector on the 
printer when the power is turned on. The failure to follow this caution can 
damage the printer.

Notes
Notes provide additional information about a particular topic.

For example:
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Note: You can set the password protection for some functions to prevent any 
access that is not authorised.

User Interface Terminology
Each set of commands visible on the printer display screen at one time is called a 
frame. For example, the screen shown in Figure 1-1 is Frame <01 Edit>.

The frames and menus of the user interface (UI) are shown between two angle 
brackets (for example, <02 Edit>).

The writing style used to indicate different keys on the control panel is shown in 
Table 1-2.

Key Style Used

Left arrow key

Right arrow key

Up arrow key

Down arrow key

Table 1-2: Content Presentation Style 

Figure 1-1. 01 Edit Frame
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ENTER key 

Esc key

F1 key

F2 key

F3 key

F4 key

F5 key

ALT key

CTRL key

 SHIFT key

HEAD key

 PRINT key

CANCEL key

Key Style Used

Table 1-2: Content Presentation Style (Continued)
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Abbreviations and Acronyms

Chapters in the Manual

 DELETE key

Abbreviation Expansion

AC Alternating Current

CDA Clean Dry Air

LED Light Emitting Diode

LCD Liquid Crystal Display

UI User Interface

WYSIWYG What You See Is What You Get

Table 1-3: Abbreviations and Acronyms 

Chapter 
No.

Chapter Name Description

 1. Introduction Contains the information about this manual, the related 
publications, and writing styles used in this manual

 2. Safety Contains the safety and hazard information

 3. Main Parts Describes the main parts of the printer

 4. Printer Operation Contains the information on how to set up and operate the printer

 5. User Interface Explains how to use the UI to create and save messages

 6. Maintenance Contains the information on how to maintain and clean the 
printer

Table 1-4: List of Chapters

Key Style Used

Table 1-2: Content Presentation Style (Continued)
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 7. Troubleshooting Contains the operator level diagnostic and troubleshooting 
procedures

 8. Specifications Contains printer specifications

 9. Software Summary 
Chart

A guide for easy navigation in the UI

 10. Index An alphabetic guide to help you locate important information 

Chapter 
No.

Chapter Name Description

Table 1-4: List of Chapters
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2Safety

Introduction
The policy of Videojet Technologies Inc. is to manufacture non-contact 
printing/coding systems and ink supplies that meet high standards of 
performance and reliability. We enforce strict quality control techniques to 
eliminate potential defects and hazards in our products.

The intended use of the printer is to print information directly onto a 
product. Use of this equipment in any other fashion may lead to serious 
personal injury.

The safety guidelines provided in this chapter are intended to educate the 
operators on all safety issues so that the printer is serviced and operated in 
a safe manner.

General Safety Guidelines
• Always refer to the correct service manuals as per the specific Videojet 

printer model for important details.

• Only Videojet-trained personnel must carry out installation and 
maintenance work. Any such work undertaken by unauthorized 
personnel may damage the printer and will invalidate the warranty.

• To avoid damage to the printer components, use only soft brushes and 
lint free cloths for cleaning. Do not use high pressure air, cotton waste, 
or abrasive materials.

• The printhead must be completely dry before attempting to start the 
printer, otherwise the printhead may get damaged.

• Do not fit or remove any connector on the printer when the power is 
turned on, otherwise the printer may get damaged.
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Electrical Safety Guidelines
This section explains the safety guidelines related to electrical power 
supply and electrical cables.

Electrical Power Supply

Warning

PERSONAL INJURY. Lethal voltages are present within this 
equipment when it is connected to the mains electrical supply. Only 
trained and authorized personnel must carry out the maintenance 
work.

Warning

PERSONAL INJURY. Observe all statutory electrical safety codes 
and practices. Unless it is necessary to run the printer, disconnect the 
printer from the mains electrical supply before removing the covers 
or attempting any service or repair activity. Non-adherence to this 
warning can result in death or personal injury.

Warning

PERSONAL INJURY. A high AC voltage is present at the inverter 
and backlight. Extreme caution is required when diagnosing failure 
in these areas.
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Electrical Cables

Warning

PERSONAL INJURY. Use only the main power cable supplied with 
the printer. The end of this cable must have an approved, three-pole, 
main plug that has a protective ground conductor.

The electrical power cables, sockets and plugs must be kept clean 
and dry.

For pluggable equipment, the socket-outlet must be installed near 
the equipment and must be easily accessible.

Warning

PERSONAL INJURY. Always inspect the cables for damage, wear, 
corrosion, and deterioration. Make all grounding/bonding 
connections void of areas of paint, ink build-up, and corrosion.

Grounding and Bonding

Warning

PERSONAL INJURY. The printer must be connected to an AC 
power supply that has a protective ground conductor and must be 
according to IEC requirements or applicable local regulations. 

Warning

PERSONAL INJURY. Do not use the printer if there is any 
interruption in the protective ground conductor or if the protective 
ground conductor is disconnected. The failure to follow this warning 
can cause an electrical shock. 
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Warning

PERSONAL INJURY. Always ground conductive equipment to an 
earthing electrode or to the building grounding system with 
approved cables as per NEC standards in order to drain all potential 
static discharge. For example, a metal service tray to earth ground.

Warning

PERSONAL INJURY. A resistance reading from the grounded 
service tray to the equipment chassis or mounting bracket should be 
0 to less than 1 ohm. A resistance check should be made using a safe 
and reliable ohmmeter and should be done on a frequent basis.

Warning

PERSONAL INJURY. The PCBs contain static sensitive devices. A 
suitably grounded, antistatic wrist strap must be worn when 
working on or handling PCBs.

Warning

PERSONAL INJURY. Always prevent static discharge from 
occurring. Use proper Grounding and Bonding methods. Only use 
Videojet approved metallic service trays and ground cables.

Warning

PERSONAL INJURY. Always bond conductive equipment together 
with approved cables to maintain them at the same potential and 
minimize static discharge. For example, printhead to metal service 
tray.
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Warning

PERSONAL INJURY. The Optional Wash Station has been solely 
designed for the cleaning of the printhead. 

Do not use it for purging or printing operations or for any other 
purposes.

Always ensure that the jet is stopped and that any hazardous 
voltages are switched off prior to the commencement of the 
printhead wash down.

Caution

EQUIPMENT DAMAGE. Always empty the service trays 
frequently. Some inks and cleaning solutions are flammable. Make 
sure that the waste fluids are disposed according to HAZMAT.

Fuses

Warning

PERSONAL INJURY. To ensure continued protection against fire 
hazards, replace fuses only with the specified type and rating.

Fluid Safety Guidelines
This section describes the hazards that may occur while handling ink, 
make-up fluid, and cleaning solutions, and the safety precautions that a 
user must take to prevent the hazards.

Read the Material Safety Data Sheets
Read and understand the Material Safety Data Sheet (MSDS) before using 
any ink, make-up fluid, or cleaning solution. An MSDS exists for each type 
of ink, make-up fluid, and cleaning solution. For more information, visit 
www.videojet.com and navigate to Documentation > Material Safety Data 
Sheets.
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Ink and Make-up Fluid

Warning

PERSONAL INJURY. The ink and make-up fluid are irritating to the 
eyes and respiratory system. To prevent personal injury when 
handling these substances:

Always wear protective clothing and rubber gloves.

Always wear goggles with side-shields or a face mask. It is also 
advisable to wear safety glasses when carrying out maintenance.

Apply barrier hand cream before handling ink.

If ink or make-up fluid contaminates the skin, wash immediately 
with soap water. DO NOT use washdown or solvent to clean ink 
stains from the skin.

Warning

PERSONAL INJURY. The ink and make-up fluid are volatile and 
highly flammable. They must be stored and handled in accordance 
with local regulations.

Do not smoke or use a naked flame in the vicinity of these 
substances.

Immediately after use, remove any tissue or cloth that becomes 
saturated with these substances. Dispose all such items in 
accordance with the local regulations.

In the event that any ink or make-up fluid container is not 
completely empty after use, it should be resealed. Only full bottles 
are recommended for use when replenishing ink or make-up fluid; 
partially filled bottles must be disposed in accordance with the local 
regulations.

Warning

PERSONAL INJURY. When setting up the nozzle, direct the ink 
stream into a beaker or suitable container. To avoid the 
contamination of the ink, do not re-use any ink collected in this way. 
Dispose all waste ink in accordance with the local regulations.
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Warning

PERSONAL INJURY. Prolonged breathing of make-up fluid or 
cleaning fluid vapor may cause drowsiness and/or effects similar to 
alcoholic intoxication. Use only in open, well-ventilated areas.

Cleaning Solution

Warning

PERSONAL INJURY. The cleaning solution is poisonous if taken 
internally. Do not drink. Seek medical attention immediately if 
ingested.

Warning

PERSONAL INJURY. The cleaning solution is irritating to the eyes 
and respiratory system. To prevent personal injury when handling 
this substance:

Always wear protective rubber gloves and clothing.

Always wear goggles with side-shields or a face mask. It is also 
advisable to wear safety glasses when carrying out maintenance.

Apply barrier hand cream before handling ink.

If cleaning solution contaminates the skin, rinse off with running 
water for at least 15 minutes.

Warning

PERSONAL INJURY. The cleaning solution is volatile and highly 
flammable. It must be stored and handled in accordance with local 
regulations.

Do not smoke or use a naked flame in the vicinity of the cleaning 
solution.

Immediately after use remove any tissue or cloths that become 
saturated with cleaning solution. Dispose all such items in 
accordance with local regulations.
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Caution

EQUIPMENT DAMAGE. Ensure that the cleaning solution is 
compatible with the ink used before carrying out printhead cleaning 
otherwise the printhead may get damaged.

Caution

EQUIPMENT DAMAGE. Any cleaning solutions containing either 
chloride, including hypochlorite bleaches or hydrochloric acid, can 
cause unacceptable surface pitting and staining. These should not be 
used in contact with stainless steels. If wire brushes or wire scouring 
pads are used, these should be made of stainless steel. Make sure 
that any abrasive media used is free from sources of contamination, 
especially iron and chlorides.

Compressed Air Safety Guidelines

Warning

PERSONAL INJURY. Airborne particles and substances are a health 
hazard. Do not use high pressure compressed air for cleaning 
purposes. 

UI Related Safety Guidelines

Caution

DATA SECURITY. To prevent unauthorized access to the software, 
navigate to the <01 Edit> frame, press the F1 key (with Password 
Protection set to On) and pressing the Enter key.
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Caution

RISK OF DATA LOSS. Ensure the correct message name is selected 
for message deletion as no message selection confirmation prompt is 
given.

Other Important Guidelines

Caution

EQUIPMENT DAMAGE. After a Quick Stop, the machine should 
not be left in this state for any length of time as drying ink may make 
restarting difficult.

Caution

EQUIPMENT DAMAGE. The printhead must be completely dry 
before attempting to start the printer otherwise the EHT will trip. 

Warning

PERSONAL INJURY. If the battery is replaced by an incorrect type, 
it will lead to an explosion. Always dispose off the used batteries 
according to the instructions and local regulations.

Warning

 PERSONAL INJURY. In a fault condition, heater can reach 70 oC. 
Do not touch the plate on which the heater is mounted. The failure to 
follow this warning can cause personal injury. 
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3Main Parts

Videojet 1520 Excel Printer

1

24

5

3

1. Control Panel
2. Ink Compartment
3. Printhead
4. Umbilical

5. Connector Panel
6. Electronics Compartment*
7. Main Power Switch*
8. Back Filter*

*The components are not shown in the picture.

Figure 3-1: Main Parts of the Printer (Videojet 1520)
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Control Panel
You can use the control panel (Figure 3-2) to do the following tasks:

• Start and stop the printer

• Create, edit, copy and delete the print messages

• Select a message to print

• Monitor the status of the printer

• Configure and control the printer functions

Note: You can set the password protection for some functions to prevent any 
access that is not authorised.

Note: Language specific keypads are provided with the language kits.

Status LEDs
The light emitting diodes (LEDs) (item 1, ) indicate the system status.

Figure 3-2: Control Panel

1. Status LEDs
2. Arrow Keys
3. Keypad

4. Function Keys
5. Contrast Key
6. Display

1

2

3

4

5

6



Rev AA Control Panel     3-3

Videojet 1520 Excel Operator Manual

Arrow Keys
The arrow keys (item 2) allow the operator to position the cursor when creating/
editing a message or graphics and scrolling through options in a list of options.

Keypad
The keypad (item 3) is 72 key, QWERTY, membrane type with tactile response 
keys. The solvents that you use for printing and maintenance do not damage the 
keypad.

Display
The Quarter Video Graphics Array (QVGA) Liquid Crystal Display (LCD) (item 
6) has a resolution of 320 x 240 pixels. The LCD has an LED backlight to help 
you see in low light conditions.

Contrast Keys

The contrast keys  (item 5) help the operator to increase or decrease 
the contrast of the LCD.

Function Keys
The function keys F1 to F5 (item 4) help the user to navigate through the UI.

Figure 3-3: Function Keys
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Display Screen
The display screen displays the following elements.

• The icons that indicate the printer status and fault conditions.

• The icons that indicate the fluid levels in the ink and make-up fluid 
cartridges.

• Different menus
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Electronics Compartment
The electronics compartment contains the parts shown in Figure 3-4.

Note: When a customer orders a Videojet 1520 Excel printer with an air dryer, the 
positive air pump is removed from the printer. The air dryer supplies positive air 
to the printhead from an external air source. Air dryers are required when the 
printer is operated in an environment with elevated humidity or where certain 
water sensitive inks are used. Please contact Videojet Technologies Inc. Customer 
Service Department at 800.843.3610 (United States only), or contact the local 
Videojet Technologies Inc. representative for more information.

1

2

3

4

5

6

1. Electronics Compartment Fan
2. Power Supply Unit (PSU)
3. Positive Air Pump
4. Control System Board (CSB)

5. Printer Interface Board (PIB)
6. EHT Module
7. Connector Panel Boards*

* - Component is not shown in the figure

Figure 3-4: Electronics Compartment (Videojet 1520)
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Ink Compartment
The ink compartment of the printer contains the ink core module, and the smart 
ink and make-up fluid cartridges. The cooling fan cools the ink compartment and 
a filter does not allow the dust into the ink compartment.

Ink Core Module
The ink core module maintains the pressure and viscosity of the ink in the printer, 
and contains the following parts:

• Ink Module

• Ink Pump

Note: The ink core module comes as a single unit. You cannot remove or replace 
any part inside the ink core module except the ink pump.

Figure 3-5: Ink Compartment

1. Ink Cartridge
2. Make-up fluid Cartridge
3. Ink Core Module

4. Ink Compartment Fan*
5. Gutter Pump*

*The components are not shown in the picture.
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Smart Cartridge

Note: Refer to “Replace Smart Cartridges” on page 6-4 to replace the cartridges.

The smart cartridges use the smart chip technology to ensure the proper and in 
shelf-life ink and make-up fluids are used.

Ink Compartment Fan
The ink compartment fan cools the ink module and the ink pump.

Printhead and Umbilical
The printhead uses the ink supplied by the ink core module to print the text and 
graphic characters on a product. The control signals and ink are sent to the 
printhead through the umbilical.

2

1

1. Umbilical
2. Printhead

Figure 3-6: Printhead and Umbilical (Videojet 1520)
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Connector Panel
The connector panel is on the left side of the printer (item 5, Figure 3-1 on 
page 3-1). The panel contains the connectors shown in Figure 3-8 on page 3-9.

Note: The number of connectors provided depends on the model you select.

Table 3-1 provides the connectors for the printer.

Connector Type PCB Standard Optional

Print Trigger 1 PCB 1 Videojet 1520 Excel -

COMMS RS232 PCB 2 Videojet 1520 Excel -

COMMS RS485 PCB 1 Videojet 1520 Excel -

Shaft Encoder PCB 2 Videojet 1520 Excel -

Relay Switches PCB 1 Videojet 1520 Excel -

Status Output
(Lampstack)

PCB 2 Videojet 1520 Excel -

USB - Videojet 1520 Excel -

Message A Input PCB 3 - Videojet 1520 Excel

Print Trigger 2 PCB 3 - Videojet 1520 Excel

Message B Input PCB 3 - Videojet 1520 Excel

Ethernet - Videojet 1520 Excel -

Table 3-1: Connector Panel Ports 

2 1

90° Printhead

1. Umbilical
2. Printhead

Figure 3-7: Printhead and Umbilical 
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Pinout Information

Connector Pinout 

Print Trigger 2 (Reverse Print) DIN 3 Pin

Status Output (Lampstack) DIN 6 Pin

Shaft Encoder DIN 4 Pin

Relay Switches DIN 7 Pin

Print Trigger 1 DIN 3 Pin

USB -

Ethernet -

Table 3-2: Connector Pinout Information

1. Message A Input
2. Print Trigger 2 (Reverse Print)
3. Status Output (Lampstack)
4. Shaft Encoder
5. Relay Switches
6. Print Trigger 1

7. USB
8. Ethernet
9. COMMS RS485
10. COMMS RS232
11. Message B Input

Figure 3-8: Connector Panel

Cat 5e

1

2

3
4

5
6

7

8

9

10

11
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Main Power Switch
The main power switch (item 1, Figure 3-9) is a green push button to turn the 
printer on and off. You can find the main power switch on the right side of the 
printer.

Note: The handles (item 2) are provided for easy movement of the unit. 

Back Filter
The ink compartment fan draws the air from the outside atmosphere to keep the 
ink compartment cool. The back filter removes the dust from the air that goes 
inside the ink compartment. The IP55 back filter is standard for Videojet 1520 
Excel The IP65 back filter is optional for Videojet 1520 Excel.

COMMS RS485 (180° Pin 
Position)

DIN 5 Pin

COMMS RS232 DIN 5 Pin

Message B Input DIN 8 Pin

Message A Input DIN 8 Pin

Connector Pinout 

Table 3-2: Connector Pinout Information

1

2

Figure 3-9: Main Power Switch

1. Main Power Switch
2. Handles
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Figure 3-10: Back Filter (IP55 Version) - Videojet 1520

Back Filter 

Figure 3-11: Back Filter (IP65 Version) - Videojet 1520

Back Filter 
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4Printer Operation and 
Setup

Introduction
This chapter provides the procedures to set up and operate the printer. 
The chapter describes how to perform the following tasks:

• Turn on and turn off the printer

• Head Start and stop the printer

• Print the messages

• Set up the printer

• Back up, restore, clone, and upgrade the system

• Custom Font

Printer Operation
This section describes the procedures that a user must perform to print the 
messages on a product.

Turn on the printer
Do the following tasks to turn on the printer:

1 Do the visual inspection.

2 Make sure that the electrical supply for the printer is available.

3 Press the switch to turn on the printer. The <01 Edit> frame appears 
after the printer starts. 
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Understand the UI
The knowledge of Videojet 1520 Excel UI is required to operate the printer. 
Before you begin to operate the printer, refer to the following sections in 
this manual:

• “Content Presentation” on page 5-1.

• “User Interface” on page 5-1.

Create the Messages
Refer to “Manage Messages” on page 5-19 for more information.

Head Start and Stop the Printer
The default procedures to start and stop the printer are the Head Start and 
the Head Stop. 

Note: If the Head Start or the Head Stop are not available, the printer requires 
INK ON or INK OFF. The printer cannot provide the Head Start and the Head 
Stop options if the make-up fluid is empty or if the ink core level is high. Make 
sure that the make-up fluid is not empty or the ink core level is not high. 

Figure 4-1: <01 Edit> Frame
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Caution

Do not perform the Head Start or the Head Stop many times. The 
failure to follow this caution can cause high use of flush and dilution 
of the ink. The diluted ink decreases the quality of the print.

Head Start
Do the following tasks to Head Start the printer:

Press the HEAD key on the control panel. The Jet on icon appears on the 

display screen .

Head Stop
Do the following tasks to Head Stop the printer:

Press the HEAD key on the control panel. The Jet off icon appears on the 

display screen .

INK ON and INK OFF (start and stop the printer)
The INK ON sequence starts without a flushing sequence, and uses the ink 
supply to remove the air from the nozzle. This sequence is used during 
maintenance and replacement procedures.

The INK OFF is used to manually stop the jet for a short period, or to 
automatically stop the jet during an EHT trip etc. INK OFF procedure is 
primarily intended for situations where the machine must be stopped and 
restarted several times in quick succession. 

INK ON
Do the following tasks to INK ON the printer:

1 Navigate to the frame <02 Service>. 

2 Press the F1 key until ON appears above Ink menu. The printer turns 
on the ink and the ink jet starts.

INK OFF
Do the following tasks to INK OFF the printer:

1 Navigate to the frame <02 Service>. 

2 Press the F1 key until OFF appears above Ink menu.
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Print a Message
The procedures in this section show how to print a message normally (as 
soon as the printer receives a product detect signal) or with a delay (some 
time after the printer has received a product detect signal).

Load a message into the printer after you have done any of the following:

• Created a new message

• Made changes to an existing message

• Recalled a message from storage

Note: When a message appears in the display screen, that does not necessarily 
mean it was the last message loaded into the printer. It may be a message that is 
currently being created or edited. Therefore, you should always load the desired 
message into the printer before printing. This will ensure that the correct message 
is printed.

Figure 4-2: <02 Service> Frame
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Criteria for Printing a Message
The following criteria must be met for printing a message:

• The message must be loaded into the printer by selecting the <Print 
Message> option (<01 Edit> or <03 Edit>).

• The green LED must be solid green along with the solid jet running 
icon at the top of the display screen. The PRINT key must be pressed 
with the message "Printing" shown at the top of the display.

Note: The printer can print a message while in the Service mode by pressing <F3 
Test Print> located in Frame <02 Service>. Refer to “Software Summary Chart” 
on page B-1 to find <02 Service>.

Print Without any Delay
Do the following tasks to print a message without any delay:

1 Make sure that the message you need to print appears in the display 
screen:

• Use the keypad and enter the required message.

• Recall a stored message. Refer to “To Recall a Stored Message” on 
page 5-23.

2 Is the message that appears in the screen loaded into the printer?

• If YES, continue to the next step.

• If NO, go to Frame <01 Edit> or <03 Edit>). Press the F4 key to 
select <Print Message>. The message “Message Loaded” appears 
on the display screen.

3 Is the green LED turned on, and is the solid jet running icon appearing 
at the top of the display?

Figure 4-3: PRINT Key

Figure 4-4:  <01 Edit> Frame

Print
Message
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• If YES, continue to the next step.

• If NO, press the HEAD key and wait until the green LED is flashing 
and the jet running icon appears at the top of the screen.

Is the green LED light solid?

• If NO, press the PRINT key. If the light is still not lit, and the top of 
the display says “Not Printing”, go to <01 Edit> or <03 Edit> and 
press the F4 key to select <Print Message>. 

When the green LED is solidly lit (along with the solid jet running 
icon) and the top of the display reads “Printing”, it indicates that the 
printer will now print a message whenever it receives a product detect 
signal.

Delay Printing of a Message
You can delay the printing of a message onto a product after the product 
detect signal is received by the printer. This enables you to control the 
placement of the message on the product.

The delay value is entered in print strokes, and the entry must be from 0-
7500 for inches.

Refer to “Set Print Delay” on page 4-28, for information on how to set the 
print delay.

Note: In order to set the print delay, measure the distance from the product 
detector to the printhead (x). Next, measure the distance from the leading edge of 
the product to the point on the product where you want to start printing (y). Add 
these together (x+y). This is the delay value you must enter (see Figure 4-5 on 
page 4-7). Encoder values must be properly set for the delay to work properly.
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Nozzle Flush
During nozzle flush, the solvent from a wash bottle is directed towards 
the nozzle face, and the solvent is sucked back through the nozzle to clean 
the nozzle. Begin from frame <02 Prime> (01 Edit > 02 Edit > 03 Edit > 04 
Edit - Service Printer > 01 Service > 02 Service > 03 Service - Auto Prime > 
01 Prime > 02 Prime). See Figure 4-6 on page 4-8.

The nozzle flush routine is performed in the following conditions:

• The nozzle is clogged with the dried ink.

• The jet break up is asymmetric.

• The jet has moved its position in the gutter because of the debris 
collection in the nozzle. The removal of debris using nozzle flush 
routine should restore the original jet position assuming that nothing 
has physically moved.

Refer to the Service Manual for Nozzle Flush procedure.

X

Y

Figure 4-5: Delaying the Printing of a Message Example

Product Detector Printhead

Start Printing Here Leading Edge

Product



4-8     Printer Setup Rev AA

Videojet 1520 Excel Operator Manual

Printer Setup

Set Display Language
The user can change the language displayed in the UI.

Do the following tasks to set the display language in the UI:

1 Begin in frame <04 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-up > 01 System > 02 System > 03 System > 04 System). See 
Figure 4-7.

2 Press F3 and the current language appears on the display. Use the 
cursor to navigate to the required language.

3 Press Shift and Enter to set the language.

Note: Power-cycle is performed for some of the languages after changing the 
display language for the change to take effect. 

Figure 4-6: Nozzle Flush

Nozzle
Flush

Figure 4-7: Set Display Language

Set 
Language
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Set Keyboard Language
1 Begin in frame <04 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 

System Set-up > 01 System > 02 System > 03 System > 04 System).

2 Press the F1 key on <04 System> to select <Locale Setup> and <01 
Locale> appears. See Figure 4-8.

3 Press F1 <Set Editor Font Group> on <01 Locale> to set the Editor Font 
Group. Select Chinese or Japanese for setting the Chinese and Japanese 
fonts. For other languages, select International. Perform a power-cycle 
for the changes to take effect.

4 Press F2 <Keyboard Language> to set the correct keyboard language. 
Refer to Table 4-1 for more information.

Editor Font Group Keyboard Language

Chinese • PinYin IME
• Tr Chi IME

Japanese • Japan IME
• Japanese

International • English
• European
• Greek
• Korean
• Russian
• Thai
• Turkish
• Vietnamese
• Arabic
• Bulgarian
• Eastern
• Polish

Table 4-1: Editor Font Group - Keyboard Languages

Figure 4-8: Set Keyboard Language

Set keybd
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Throw Distance
You can set the distance between the product and the printhead.

Note: If you change the throw distance value from default, the printer will require 
more initial delay to build the printed message. 

Enter the Throw Distance
Do the following tasks to enter the throw distance in the UI. 

1 Navigate to frame <06 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 
Print). See Figure 4-9.

2 Press the F1 key. The message shown in Figure 4-10 on page 4-10 
appears.

3 Enter the Throw Distance and press the ENTER key. The throw 
distance entered appears above <Throw Distance>.

Auto Print
If you enable one of the following menus, you can set the printer to start 
printing automatically:

• Ink On Start

• On Load Message

Figure 4-9:  Throw Distance 

Throw 
Distance

Figure 4-10:  Throw Distance_06 Print
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Set Automatic Print 
Do the following tasks to enable auto print:

1 Navigate to Frame <01 Autoprint> (01 Edit > 02 Edit > 03 Edit > 04 
Edit - Print Set-up > 01 Print - AutoPrint > 01 AutoPrint). See figure 
Figure 4-11.

2 Press the F1 key. The Ink On Start is enabled and Enable appears 
above Ink On Start.

Note: Press the F1 key to toggle between the enable and disable functions.

3 If you want to print the message when you select the message, press 
the F2 key. The OnSelect Message is enabled and Enable appears 
above <OnSelect Message>.

Note: Press the F2 key to toggle between the enable and disable functions.

View and Reset the Print Count
The procedures in this section show you how to view the current print 
count, and reset the print count to zeros. The print count is the number of 
messages the printer has printed. The product count and print count are 
displayed in Frame <02 Print>. 

Figure 4-11:  Auto Print

Print 
Reset

Print 
Count

Figure 4-12:  Frames <Print Reset> and <Print Count>
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View the Current Print Count
Do the following tasks to view the current print count:

1 Navigate to Frame <02 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print). See Figure 4-12.

2 View the current value above <Print Count>.

Reset the Current Print Count
Do the following tasks to reset the current print count to zeros:

1 Navigate to Frame <02 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print). See Figure 4-12.

2 Press the F4 key to select <Print Reset>. The value above <Print 
Count> changes to zeros.

View and Reset the Product Count
The procedures in this section show you how to view the current product 
count, and reset the product count to zeros. The product count is the 
number of product detect signals received by the printer. The product 
count is displayed in Frame <02 Print>.

View the Current Product Count
Do the following tasks to view the current product count.

1 Navigate to Frame <02 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print). See Figure 4-13.

2 View current value above <Product Count>.

Reset the Current Product Count
Do the following tasks to reset the current product count to zeros.

1 Navigate to Frame <02 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print). See Figure 4-13.

Figure 4-13:  <02 Print> Frame

Product 
Count

Product 
Reset
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2 Press the F2 key to select <Product Reset>. The value above <Product 
Count> changes to zeros.

Set the Product Detector
This setting sets the product detector for Continuous or External 
configuration. External product detector will require the use of an external 
product detector connected to the printer.

Do the following tasks to set the product detector:

1 Navigate to Frame <07 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 
Print > 07 Print). See Figure 4-14.

2 Press the F1 key to toggle <Product Detector> into an External 1, 
External 2 or Continuous setting.

Internal Distance
This section determines the rate at which the internal product detects will 
occur. The range is from 50 to 12500 (in 1/100th inch increments). The 
Internal Distance selection can only be initiated if the F1<Product 
Detector> is set to Internal.

Do the following tasks to set the internal distance:

1 Navigate to Frame <07 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 
Print > 07 Print). See Figure 4-14.

2 Press the F2 key to select <Internal Distance>. The following message 
appears in the display screen. 

3 Set the desired internal distance for the internal product detect setting 
and press the ENTER key.

Figure 4-14:  <07 Print> Frame 

Product 
Detector
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Active Level
This selection determines whether the product detector will activate on a 
high or low level.

Do the following tasks to set the active level:

1 Navigate to Frame <07 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 
Print > 07 Print). See Figure 4-14.

2 Press the F3 key to toggle <Active Level> to a High or Low level.

Select the Encoder
The procedures in this section show you how to set the printer for the type 
of encoding most appropriate for your application, and how to enter the 
settings for the type of encoding most appropriate for your application. 

There are four encoding settings available: Internal, Direct, Reduced, and 
Auto. Refer to Table 4-2 below to select the appropriate setting for your 
application. 

Note: Direct and Reduced are the only settings that are used with an external 
encoder.

Do the following tasks to select the encoder setting:

1 Navigate to Frame <04 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print). See Figure 4-
15.

If the Product Speed:  The Encoder Type Should be Set to:

is constant <Int> Internal

varies with conveyor <Reduced> External

<Direct> External

varies and an external 
encoder cannot be used

<Auto> Automatic

Table 4-2:Selecting the Appropriate Encoding Type

Select
Encoder

Figure 4-15:  <04 Print> Frame
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2 View the current setting above <Select Encoder>. Press the F1 key to 
change the setting (settings: Int, Auto, Direct, and Reduced). Refer to 
Table 4-3 on page 4-15 to complete the next step.

Note: Auto encoder setting can only be selected if the F1 <Product Detector> 
setting in Frame <07 Print> is set to External.

3 Press the ENTER key. 

4 This step is optional. Follow these instructions to turn Speed 
Compensation On: Navigate to frame <01 Auto-E> (04 Edit - Print Set-
up > 01 Print > 02 Print > 03 Print > 04 Print - Set-Up Auto > 01 Auto-
E). View the current setting above <Speed Comp>. If desired, press 
the F1 key to change the setting. (Settings: ON, OFF.) See Figure 4-16 
on page 4-16.

5 Press the ENTER key. Frame <04 Print> appears in the display screen.

If <SELECT 
ENCODER>
is set to:

Select: Use the Keypad
to Enter the Following Values:

<INT> <Set-Up Internal>
press (F3 key) 
and <Line Speed> 
press (F3 key)

<REDUCED> <Set-Up Exter-
nal>
press (F4 key) 
and <Encoder 
Resolution>. 
press (F3 key)

<Set-Up Exter-
nal>
press (F4 key) 
and <Reduction 
Factor>. press 
(F4 key)

<DIRECT> <Set-Up Exter-
nal>
press (F4 key) 
and <Encoder 
Resolution>, 
press (F3 key)

Table 4-3: Setting Appropriate Encoder Values 
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Auto Encoder

The printer has two options to adjust print pitch. The first is External 
Encoding (shaft encoder). This is when the product is transported on a 
conveyor or transport. The shaft encoder must be in a direct relation to the 
movement of the product for the External Encoder to work properly. If 
product moves encoder turns, product stops encoder stops.

The second varying speed option is to use Auto Encoder option. This 
option is used when a shaft encoder cannot be used since there is not way 
to track the production line movement. The Auto Encoder option requires 
a very accurate detector to sense the leading and trail edge of each product 
and adjust the width of code for every product.

Set the Line Speed
Line speed is the speed of conveyer belt in Feet/Min [or Meters/Min] on 
which the product moves. 

Navigate to Frame <01 Int-E> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-up > 01 Print > 02 Print > 03 Print > 04 Print - Set-up Internal > 01 Int-
E). See Figure 4-17 on page 4-17. Press the F1 key to toggle to change the 
settings (Settings: ON, OFF).

Speed Compensation Summary

The speed compensation feature implemented is as follows:
The user has to enter the throw distance as the distance 
between the printhead (base of the lid) and the substrate on 
which printing takes place. Now once the distance is set, the 
user can turn this compensation value On or Off based on 
enabling or disabling the Speed compensation menu option. 
Once this feature is turned on, the printer automatically 
adjusts delay in such a way that printing starts at the required 
place irrespective of the distance of the substrate from the 
print head.

Figure 4-16: <01 Auto-E> Frame
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Set the Encoder Resolution
Encoder resolution is number of pulses generated in a unit distance. 1/100 
pulses per mm [or Pulses Per Inch]. 

Navigate to Frame <01 Ext-E> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-up > 01 Print > 02 Print > 03 Print > 04 Print - Set-up External > 01 Ext-
E). See Figure 4-18.

Set Reduction Factor
When the encoder is of Reduced type, the value set in the menu option 
“Reduction Factor” is considered as the required width.

Reduction Factor = Encoder resolution (ppi) / Required no. of dots per 
inch (dpi) printed.

Navigate to Frame <01 Ext-E> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-up > 01 Print > 02 Print > 03 Print > 04 Print - Set-up External > 01 Ext-
E). See Figure 4-19 on page 4-18.

Figure 4-17:  <01 Int-E> Frame

Figure 4-18:  <01 Ext-E> Frame

Encoder 
Resolution
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Set the Internal System Clock
The procedures in this section show you how to set the internal clock. The 
clock controls the update of important variable information inserts: time, 
date, timer, hour of the week, and week of the year are all based on the 
settings entered in the internal clock.

Note: It is important that the time and date are entered into the system accurately 
so that the message inserts are accurate.

Complete the procedures listed below to accurately set the system clock:

• “Set the System Time” on page 4-18

• “Set the System Date” on page 4-19

• “Set Week of the Year and Hour of the Week” on page 4-20

• “Set the Programmable Date Roll Over” on page 4-22

Set the System Time
This procedure shows you how to set the internal system time clock. The 
system time clock is important, because time inserts, date inserts, and 
timer inserts are based on the system time clock. The time of day that 
appears in the display screen is also based on the internal system time 
clock.

The system time clock is set in Frame <01 System>.

Figure 4-19: <01 Ext-E> Frame

Reduction 
Factor
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Procedure

Do the following tasks to set the system time:

1 Navigate to Frame <01 System > (01 Edit > 02 Edit > 03 Edit > 04 Edit 
- System Set-up > 01 System). See Figure 4-20.

2 Press the F1 key to select <Set Time>. The following message appears 
in the display screen:

3 Enter 24-hour clock time, the two-digit hour-of-the-day (HH) 
followed by the two-digit minute (MM).

Example: If the time is 9:45 AM, enter 0945; 09 is the hour and 45 is the 
minute. If the time is 4:02 PM, enter 1602; 16 is the hour and 02 is the 
minute.

4 Press the ENTER key. The time appears in the display screen above 
<Set Time>. It also appears in the upper right corner of the display 
screen at all times.

Set the System Date
This procedure shows you how to set the system date. The system date is 
important, because date inserts that you print in messages are based on 
the system date that you enter here.

The system date is set in Frame <01 System>.

Note: The year range is from 00 to 99 (representing the range 2000 to 2099).

System
Set-Up

Set
Time

Figure 4-20:  <01 System> Frame
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Do the following tasks to set the system date:

1 Navigate to Frame <01 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-up > 01 System). See Figure 4-21.

2 Press the F2 key to select <Set Date>. The following message appears 
in the display screen:

3 Enter two digits for the current month (MM), followed by two digits 
for the current day of the month (DD), and two digits for the current 
year (YY).

Example: If the date is February 9, 2008, enter 020908; 02 is the month, 
09 is the day of the month and 08 is the year.

4 Press the ENTER key. The date appears in the display screen above 
<Set Date>.

Set Week of the Year and Hour of the Week
This procedure shows you how to enter the correct settings so that the 
system can determine the current week of the year insert and hour of the 
week insert values. The current week of the year is displayed in Frame <01 
System>.

Note: For Europe, there must be minimum four days in a week.

System
Set-Up

Figure 4-21:  <01 System> Frame

Set
Date



Rev AA Printer Setup     4-21

Videojet 1520 Excel Operator Manual

Do the following tasks to set the week of the year and hour of the week:

1 Navigate to Frame <01 WK/YR> (01 Edit > 02 Edit > 03 Edit > 04 Edit 
- System Set-up > 01 System - Set WK/YR > 01 WK/YR). See Figure 4-
22.

2 Is the system date set? (Refer to <Set Date> in Frame <01 System>) 
The current date appears above <Set Date> if it has been set; 
otherwise, it will be set to a default date. 

Has the date been set?

• If YES, proceed to step 3.

• If NO, follow the procedure to set the system date in “Set the 
System Date” on page 4-19. After you complete the procedure, 
return to this page and proceed to step 3.

3 Press the F4 key to select <Set WK/YR>. Frame <01 WK/YR> appears 
in the display.

4 In Frame <01 WK/YR>, complete the following steps to automatically 
enter the week of the year.

a. View the current setting above <Change WK/YR>. This is the day 
of the week upon which the week of the year will advance. If 
desired, press the F1 key and move the cursor to change the setting. 
(Settings: MON, TUE, WED, THU, FRI, SAT, SUN.)

Example: If you set the <Change WK/YR> to occur on MON, the 
week of the year setting will start at 12:00 A. M. on Monday morning 
(if the F2 <Set DayRoll> value in Frame <03 System> is set to the 
default 00:00).

b. Press the F4 key to select <First Day WK/YR>. The following 
appears in the display screen.

Figure 4-22:  <01 WK/YR> Frame

System
Set-Up

Set
WK/YR



4-22     Printer Setup Rev AA

Videojet 1520 Excel Operator Manual

Enter the starting day of the year in MMDD format: two digits for the 
month (MM), and two digits for the day of the month (DD). 

Example: If the start of the year is to be January 3, enter 0103; 01 for 
the month and 03 for-day-of-the-month.

Note: February 29 cannot be used for the starting date of WK/YR.

5 Press the ENTER key. The week of the year appears above <Week Of 
Year> in the display screen. 

6 Press the ENTER key again to return to Frame <01 System>.

7 Refer to “To Insert the Week of the Year” on page 5-41 for the 
procedure to insert the current week-of-the-year into a message.

Set the Programmable Date Roll Over
The programmable date roll-over feature allows you to program certain 
date inserts to advance at a time other than midnight (the default value). 
The printer will then update its date to the next day when the system clock 
reaches that day roll time, instead of at midnight. All day functions, 
including expiration date, expiration day, expiration month, expiration 
year, expiration alpha month, hour/week insert and julian insert will roll 
over at the time setup by this function. 

Note: Rollover from A.M. (midnight to noon) rolls over to today's date, and the 
rollover for P.M. rolls over to tomorrow's date. 
For Example,  
Today is March 20th and it’s 2.45 P.M. A message has to be printed which 
incorporates the date.

With a rollover time of 4 A.M: Between midnight and 4 A.M, the printer would 
have printed “March 19”. At 4 AM, the date rollover occurred and the printer is 
now printing “March 20th” (and will continue to do so until 4 A.M tomorrow 
morning).

With a rollover time of 11 P.M: Until 11 P.M, the printer will print “March 20”. 
At 11 PM, the date rollover will occur and the printer will print “March 21st” 
(until 11pm tomorrow).
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Do the following tasks to setup the programmable date roll over:

1 Navigate to Frame < 03 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit 
- System Set-up > 01 System > 02 System > 03 System). See Figure 4-23 
on page 4-23.

2 Press the F2 key to select <Set DayRoll>. The following message 
appears in the display screen.

3 Enter the time for the date roll-over to start; two digits for the hour 
and two digits for the minutes.

4 Press the ENTER key. The time at which certain date inserts will roll-
over appears above <Set Day Roll> in the display screen.

5 Press the ENTER key again to return to Frame <01 System>.

Set Daylight Savings
Daylight savings is advancing clocks so that afternoons have more 
daylight and mornings have less. Typically clocks are adjusted forward 
one hour near the start of spring and are adjusted backward in autumn.

Do the following tasks to set the daylight savings:

1 Navigate to Frame < 03 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit 
- System Set-up > 01 System > 02 System > 03 System). See Figure 4-23 
on page 4-23.

2 Press the F3 key to set the daylight savings.

Figure 4-23: Setting the Programmable Date Rollover

Set
DayRoll

Set
Daylight 
Settings
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Set the Baud Rate
This procedure shows you how to set the Comm 2 baud rate for external 
data transmission. This is used with the RS-232 interface. 

Do the following tasks to set the baud rate:

1 Navigate to Frame < 02 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit 
- System Set-up > 01 System > 02 System). See Figure 4-24.

2 Press the F1 key to select <Serial Comm>. The <01 Serial Sett> frame 
appears.

3 View the current setting above <RS232 Baud>. Press SHIFT+ F1 keys 
at the same time to change the setting. The allowed settings are: 150, 
300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200).

Set the Network

Note: After you complete the network settings, restart the printer for the changes 
to take effect.

Baud
Rate

Figure 4-24: <02 System> Frame

Baud
Rate
Baud
Rate
Baud
Rate

Figure 4-25:  <01 Network> Frame
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Smart Chip Data
You can view the details of the ink, make-up fluid and Ink system using 
<Ink Data>, <Makeup Data>, and <Core Data> respectively in the <01 
Service>. 

Do the following tasks to view the smart chip data:

1 Navigate to Frame < 01 Service> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Service Printer > 01 Service). See Figure 4-26 on page 4-25.

2 Press the F2 key to select <Printer Log> and Frame <01 Log> appears. 
You can view <Core Data>.

3 Press the F2 key to select <Ink Data> to view the Ink Data and 
Makeup Data.

Set Auto Repeat
This procedure shows you how to set a message to print repeatedly. The 
automatic repeat function enables you to set the number of times that a 
message will print after it receives a product detect signal.

Repeat delay is the delay between the leading edge of first product to the 
leading edge of second product.

Note: Auto repeat uses print delay value to delay the start of the first print. This 
delay changes how the continuous print feature is processed.

Note: Be careful not to confuse this function with the <Repeat Count> option in 
Frame <02 Serial> in the Insert mode. The serializer repeat count allows you to 
print the same serializer value upon successive product detects signals; the 
automatic repeat function described in this section allows you to print the same 
message multiple times on the same product after receiving a single product detect 
signal.

Figure 4-26:  <01 Ink> Frame
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Example: The auto repeat function is used effectively when marking wires 
or cables because there is no break in the product to provide separate 
product detect signals. One product detect is received and the same 
message prints continuously (to a maximum of 255 times) along the length 
of the wire or cable.

Do the following tasks to set the auto repeat function:

1 Navigate to Frame <05 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print). See 
Figure 4-27.

2 Press the F4 key to select <Auto Repeat>. Frame <01 Auto-R> appears 
in the display screen.

3 Press the F1 key to select <Repeat Count>. The following appears in 
the display screen:

4 Enter the number of times (from 1-255) that a message must print for 
each product detect signal. 

5 Press F3 key to select PEC Triggered that allows you to see the rising 
or falling edge on the photocell to start the print.

6 Or, select PEC Gated that allows you to see a steady signal (i.e. 
substrate) to keep printing.

If PEC Gated is set to On, printing will stop if the product detector 
becomes uncovered. If PEC Gated is set to Off, the printer will print 
the required number of prints, whether the product detector is 
covered or not (regardless of whether there is a substrate on which to 
print).

7 Press the ENTER key. Frame <01 Auto-R> reappears on the display 
screen.

8 Press the F2 key to select <Between Prints Dly>.

Figure 4-27:  <01 Auto-R> Frame
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9 In this frame you can make adjustments to the amount of space in 
between each message. The following message appears in the display 
screen.

Enter a number between 8-7500. This value represents the distance (in 
1/100ths of an inch) between each message.

Example: A value of 100 equals 1 inch (100 x 1/100 = 1). 

Note: This delay value represents the distance from start of the first message 
to the start of the next message.

10 Press the ENTER key to save the entry. Frame <01 Auto-R> reappears 
in the display screen.

Service Status
This procedure shows you how to view the Diagnostic Screens 1, 2 and 3, 
that include the following

• Ink Pressure Set

• Actual Ink Pressure

• Motor PWM

• Current Phase

• Manual Phase

• High Voltage

• Nozzle Drive

• Head Temperature

• Warnings and alarms and so on (refer to Chapter 7, “Diagnostics 
Screen”).

Note: Use Ctrl + S shortcut keys to toggle between the three diagnostic screens.

These settings cannot be changed in this frame; this is done in the Service 
mode. The software allows you to monitor the settings while the system is 
printing, rather than turning printing off to check settings in the Service 
mode.
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1 Navigate to Frame <03 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-up > 01 System > 02 System > 03 System). See Figure 4-28.

2 Press the F4 key to select < Status Screens>. Service Status frame 
appears in the display screen (see Figure 4-28). View the current 
readings above each of the labels in this frame (values may differ 
depending upon the printer status). 

3 Press the ENTER or CANCEL key to escape this frame. Frame <03 
System> appears in the display screen.

Set Print Delay
The print delay function is used to change the position of a printed 
message on a product. The number you enter represents the number of 1/
100 inch units that are used to delay the message prior to printing. The 
delay can be a maximum of 7500 units, which equals 75 inches (7500 x 1/
100” = 75 inches). Keep in mind that each unit is 1/100 inch when the 
display units are set to inches.

When Would You Use Print Delay?
In some applications, it is easier to enter a print delay to change the 
position of a message than to change the product detect set-up 
information, or to add spaces at the beginning of a message.

The print delay is set in Frame <01 Print>.

Figure 4-28:  < Status Screens> Frame
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Do the following tasks to set the print delay:

1 Navigate to Frame <01 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print). See Figure 4-29.

2 Press the F4 key to select <Print Delay>. 

3 In this frame you can make coarse and fine adjustments to the 
distance allowed (delay) before the message is printed:

To make a coarse adjustment to the delay, press the F1 key to select 
<Coarse Adjust>. The following message appears in the display 
screen:

This value represents the distance (in inches) allowed before the 
message is printed. 

Example: A value of 100 equals 1 inch (100 x 1/100 = 1).

• To make a fine adjustment to the delay, press the F3 key to select 
<Fine Adjust>. The following message appears in the display 
screen:

Note: The fine adjustment may be made while printing so that the 
adjustment may be made dynamically.

Note: Use the arrow keys to adjust the values. The Up and Down arrow keys 
increase/decrease the value by 1 unit. The Right and Left keys increase/
decrease the value by 10 units.

Print
Delay

Figure 4-29:  <01 Delay> Frame
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4 Press the ENTER key to save the entry.

Set Print Set-up Parameters
The procedures in this section show you how to store, recall, and reset 
parameters that you have set in the Print Set-up mode. Up to two sets of 
parameters can be stored with this feature. The recall feature allows you to 
apply the set-up parameters to different messages. This saves you from re-
entering the same information repeatedly as your applications change. 

The following values are stored in memory when you store the print set-
up parameters. Refer to the page numbers listed below for the specific 
procedures.

Procedures found in Chapter 5, “User Interface”:

• “To Reverse a Message” on page 5-29

• “To Invert a Message” on page 5-30

• “To Reverse a Character” on page 5-16

• “To Change the Message Multi-Stroke (Bold)” on page 5-28

• “To Adjust the Height of a Message” on page 5-25

• “To Adjust the Width of a Message” on page 5-26

Procedures found in this chapter:

• Encoder set-up (Refer to procedure from “Select the Encoder” on 
page 4-14) 

• Set Auto Repeat (Refer to “Set Auto Repeat” on page 4-25)

• Set Print delay (“Set Print Delay” on page 4-28)

Note: Product count and Print count values are not stored in memory when you 
store the set-up parameters.

Store Set-up Parameters
Do the following tasks to set the print set-up parameters.

Figure 4-30:  <05 Print> Frame 

Recall 
Set-Up

Store
Set-Up

Reset 
Set-Up
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1 Navigate to Frame <05 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Print Set-up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print). Refer 
Figure 4-30.

Note: Complete this procedure after you have entered all appropriate settings 
in the Print Set-up modes.

2 Press the F1 key to select <Store Set-Up>. The following message 
appears in the display screen.

3 Enter a value 1 through 5 or enter a name (8 characters) to indicate the 
number of the storage location. 

4 Press the ENTER key.

Recall Setup Parameters
Do the following tasks to recall print set-up parameters:

1 Navigate to Frame <05 Print>. Refer Figure 4-30 on page 4-30.

2 Press the F2 key to select <Recall Set-Up>. The following appears in 
the display screen:

3 Enter a value 1 through 5 to indicate the number of the storage 
location.

4 Press the ENTER key.

Note: You can enter the assigned name of the setup and it appears on the 
display screen automatically.

Reset Set-up Parameters
This procedure shows you how to reset print set-up parameters. This 
function resets the values to the factory default parameters.

Note: The ink jet must be off to reset parameters.

Do the following tasks to reset the print set-up parameters:

1 Navigate to Frame <05 Print>. Refer Figure 4-30 on page 4-30.
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2 Press the F3 key to select <Reset Set-Up>. All values in the Print Setup 
mode (except product count and print count) will reset to the default 
values. The message “Reset Value Restored” appears on the display 
screen.

System Backup
You can make a backup copy of all configured settings and messages to a 
USB drive.

Note: You can perform a full system backup after you have set up the system.

Do the following tasks to make a system backup:

1 Navigate to Frame < 05 Service> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Service Printer > 01 Service > 02 Service > 03 Service > 04 Service > 05 
Service). Refer Figure 4-31.

2 Press the F1 key to select <System BackUp>. The following message 
appears in the display screen.

3 Press the ENTER key. Backup is finished when the display message 
reads “Backup complete”.

System Restore
You can restore all configured settings and messages, from the backup 
copy on the USB drive.

Note: For example, when a CBS has failed, you can run a full system restore to 
recover the lost settings.

Figure 4-31:  <05 Service> Frame
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Do the following tasks to restore the configured settings and messages:

1 Navigate to Frame < 05 Service> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Service Printer > 01 Service > 02 Service > 03 Service > 04 Service > 05 
Service). Refer Figure 4-31.

2 Press the F2 key to select <System Restore>. The following message 
appears in the display screen.

3 Press the “Y” key.

The following message appears in the display screen.

System Clone
This procedure shows you how to make an identical copy of the current 
configured settings and messages to the USB drive located in the USB 
connector.

Note: You can perform a system clone to transfer messages between two systems.

Warning

Do not transfer settings data like viscosity parameters to other 
printers.

1 Navigate to Frame < 05 Service> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Service Printer > 01 Service > 02 Service > 03 Service > 04 Service > 05 
Service). Refer Figure 4-31 on page 4-32.

2 Insert a USB drive into the USB connector.

3 Press the F3 key to select <System Clone>. The following message 
appears in the display screen:
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4 Press the “Y” key if a blank USB drive is in USB connector.

The system displays “Backup complete”. The system will not allow a 
backup if a USB drive is not in the USB connector. 

System Upgrade
You can upgrade the current configured settings and messages from the 
USB drive located in the USB connector. 

Do the following tasks to upgrade the configured settings and the 
messages:

1 Navigate to Frame < 05 Service> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
Service Printer > 01 Service > 02 Service > 03 Service > 04 Service > 05 
Service). Refer Figure 4-31 on page 4-32.

2 Verify if the USB drive is in the USB connector.

3 Press the F4 key to select <System Upgrade>. The following message 
appears in the display screen.

Note: You can perform a software upgrade to upgrade only the required 
settings and selected elements. The options are:

• All

• Fonts

• Application - software version

• Messages - move all the messages

• Settings - HV calibration, viscosity

• Rasters

4 Press the ENTER key. The following message appears in the display 
screen.
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How to Install and Print Custom Fonts
This procedure shows how to work with Custom font and print messages. 
The custom font file must be installed in the printer. 

• Custom Font height must match with the height of the standard font 
available in the printer. Following are the list of the available font 
height.

- 5-high

- 7-high

- 9-high

- 12-high

- 16-high

- 24-high

- 34-high

• Custom font file must be in *.abf2 format.

• The naming convention of the font must be in xxhigh_custom.abf2. xx 
represents the height of the font. (Ex: A 16-high custom font file must 
be named as 16high_custom.abf2).

Installation
Do the following tasks to install a custom font:

1 Navigate to Frame < 02 Info> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-up > 01 System > 02 System > 03 System > 04 System - 
System Info > 01 Info > 02 Info).

2 Copy the custom font you wish to install to the root of a USB Flash 
Drive.

3 Insert the USB Flash Drive in the USB socket on the side of the printer.

4 Press the F3 key to select <Update From USB>.

5 Select the required font file from the USB.

6 Press the ENTER key. The following message appears in the display 
screen.
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Note: User must wait for few seconds until the note appears to power cycle the 
printer.

7 Press Esc and power cycle the printer.

Create and Print a Message
Do the following tasks to create and print a message using custom font:

1 Navigate to <01 Font> (01 Edit > 02 Edit - Font Setup> 01 Font).

1 Press F4 key to set the <Custom Font>.

2 Press F2 key to select <Print Matrix>. 

Note: Set the font height to match the custom font height. For example, if the 
custom font is 16-high, select either the 10 x 16 print matrix with the 
character height set to Double, or the 30 x 34 print matrix with the character 
height set to Single.

3 Enter the message in the message editor. The characters are displayed 
in custom font.

Note: If you require the fonts in ‘Standard’ font, turn off the Custom Font 
feature. All subsequent characters entered will appear in standard font.

4 Navigate to <01 Edit> or <03 Edit>.

5 Press F4 to print the message.

Turn off the Printer

Caution

EQUIPMENT DAMAGE. Turn off the printer after the jet shutdown 
cycle is complete. The failure to follow this caution can cause 
additional maintenance.
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Caution

EQUIPMENT DAMAGE. Do not start and stop the printer many 
times. 

When you stop the printer, the printer uses the make-up fluid to 
flush the system. If you start and stop the printer many times, the 
printer uses large amount of make-up fluid. The increased use of 
make up fluid can cause a Ink Core Level High error and low ink 
viscosity. To prevent this problem, INK ON and stop must be used.

Press the main power switch to turn off the printer.

Note: It is recommended to start the printer once in every 10 days. If the printer is 
shutdown for more than 10 days, it is recommended to follow the extended 
shutdown routine. Refer to “How to Prepare for Long-term Shutdown (Storage) or 
Transportation” on page 6-2 for the procedure.
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5User Interface

Introduction
This chapter provides information on the tasks you can perform using the 
1520 Excel User Interface. The tasks you can perform using this interface 
are as follows: 

• Create messages

• Add inserts into messages

• Store messages

• Print messages

Content Presentation
Refer to “User Interface Terminology” on page 1-4 for information on the 
different writing styles used to indicate UI elements and different keys on 
the control panel.

User Interface
When you turn on the printer, Frame <01 Edit> appears on the display 
screen. Each set of commands visible on the printer display screen at one 
time is called a frame. The Figure 5-1 on page 5-2 shows the Frame <01 
Edit>.



5-2     Introduction Rev AA

Videojet 1520 Excel Operator Manual 

The different frames of the software, and the navigation through these 
frames is illustrated in the software summary chart (refer to Appendix B, 
“Software Summary Chart”).

To Select the Frames and Menus
To select the menus, and navigate through different frames, you can use 
the ”F” keys.

F Keys

The F keys (F1, F2, F3, F4, and F5) allow you to select a particular menu in 
a frame, or, in certain cases, to move from one frame to the next. Move 
from frame to frame in the software by pressing the F keys located below 
the display screen. The illustration in Figure 5-2 shows how the F keys are 
positioned in relation to the words on the display screen.

Note: Arrow keys are used to toggle the values.

Figure 5-1: <01 Edit> Frame
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Enter Key

You can come back to the first level screen, if you press the ENTER key. 

For example:

• If you are in the frame <04 Edit>, and you press the ENTER key, you 
come to frame <01 Edit>.

• If you are in <02 Insert>, and you press the ENTER key, you come to 
<01 Insert>.

Esc Key

To exit from a menu without any change in the settings, press the Esc key.

Figure 5-2: F Keys
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To Enter Text, Numbers and Toggle Values

To Change the Case of the Fonts
To enter a character into the message, press the key for that character. The 
printer will place the uppercase version of that character into the message 
at the current location of the cursor.

If in uppercase mode and you want to create a lowercase character, press 
the CAPS LOCK key or the SHIFT key and the key for the desired 
character at the same time.

The required message may contain both upper and lower case characters. 
Table 5-1 shows the keys on the keypad that control the case of characters 
being typed.

Password
You must enter the password on power-up, unless password protection 
has been disabled.

There are 4 levels of password:

•  Level 0 - Password not required. Provides minimal access to menus. 

• Level 1 - Provides access to the Print Set-up menu and some basic 
service functions.

•  Level 2 - Provides access to the menus which are accessible at Level 1 
and to the System menu.

•  Level 3 - Provides full access to menus. Level 3 access is usually 
provided to Videojet Service personnel.

Text Use the keypad to enter the required text or special 
characters. 

Numerical values Use the keys 0 to 9.

Toggle values
(for example, On 
or Off)

Press the specific F key to switch from On or Off states

Key Function

Pressing the CAPS LOCK key changes the 
default case.

Table 5-1: Keys to Change Case of Text
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Password is not required to access Level 0. The user with Level 2 access 
can change the password to Level 1 or Level 2. It is possible to disable 
password protection to access Level 2 without entering the password.

To Enter the Password
Do the following tasks to enter the password:

1 Press the F1 key in the <01 Edit> frame. 

2 Enter the password and press the Enter key.

Main Software Menu Groups
The Videojet 1520 Excel software can be divided into the following menu 
groups:

Note: Refer to ‘Appendix B, “Software Summary Chart” for complete 
information on the software menu groups.

• Edit 

- Character Setup

- Insert

• Service 

• System Setup

• Print Setup 

Edit Menu
The software is in the Edit menu when the printer is turned on. The frames 
in the Edit menu are used to enter, edit, select, create, edit and store 
messages. The Edit menu is shown in Figure 5-4.

Figure 5-3: 01 Edit Menu
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Character Setup Menu
Use this menu to change the orientation and appearance of individual 
characters in a message.

Insert Menu
An insert is an element containing variable information that can be placed 
into a message. The insert menu is shown in the Figure 5-6 on page 5-9.

Figure 5-4: Edit Menu

Figure 5-5: Character Set-up Menu
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Service Menu
The Service menu is intended for use by personnel who have the proper 
training and experience to work with this equipment and are aware of the 
hazards to which they will be exposed. Qualified personnel should refer to 
the Videojet 1520 Excel Service Manual for information on the Service 
menu. Level 3 provides full access and level 0 allows no access. 

Figure 5-6: Insert Menu
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System Setup Menu
The System Set–up menu is used during printer installation to enter 
parameters such as date and time, which become part of the printer 
memory. The System Set–up menu is shown in Figure 5-8 on page 5-13. 
Level 3 provides full access and level 0 allows no access.

Figure 5-7: Service Menu
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Figure 5-8: System Set-Up Menu
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Print Set-up Menu
The Print Set-up menu allows the operator to set specific printing 
parameters that apply to the entire message. The Print Set-up menu is 
shown in Figure 5-9 on page 5-15.
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Manage Text
The procedures in this section show you how to create characters that are 
reversed or inverted, or bold within a message. The procedure to change 
character spacing in messages is also explained in this section.

Note: To apply reverse, invert, bold, or Reverse All Characters to an entire 
message, refer to “To Apply Attributes to Messages” on page 5-27.

You can create a character that is a combination of these features. For 
example, you can create a character that is both reversed and inverted at 
the same time, or you can create a character that is reversed and bold at 
the same time.

Note: Reverse message, invert message, and bold message settings do not override 
individual character settings. The two settings are combined.

To Change the Character Multi-Stroke (Bold)
You can change the multi-stroke value of an individual character within a 
message. Changing the multi-stroke (bold) value makes the character 
bolder by increasing the number of vertical strokes of ink drops used to 
create each character.

When you increase the multi-stroke value, the thickness (darkness) of the 
character changes. Only new characters can be made bold; you cannot 
change an existing character in the message to bold type.

Do the following tasks to change the multi-stroke value of an individual 
character:

Figure 5-9: Print Set-Up Menu
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1 Use the arrow keys to move the cursor to the location in the message 
where you want the character to appear.

2 Begin in Frame <01 Char> (01 Edit > 02 Edit - Char Set-Up > 01 Char). 
Refer to Figure 5-10.

3 View the current setting above <Multi-Stroke>. If desired, press the F1 
key to change the setting (Settings: 1, 2, 3, 4.). 
Table 5-2 lists the multi-stroke settings and their descriptions.

4 Enter the new character into the message. The character will appear in 
the display screen as bold.

Note: The next character entered will have the same multi-stroke (bold) value 
setting as the previous character unless you press the F1 key to change the 
setting before entering the next character.

To Reverse a Character
This procedure explains how to reverse individual characters within a 
message. Reversing a character creates a mirror image of the character. It 
does not rotate the character. Refer to Figure 5-11. Only new characters 
can be reversed. You cannot reverse an existing character in the message.

Multi-Stroke 
Setting

Description

<1> This indicates the normal (default) setting. 

<2> This indicates that the character will be twice as 
bold as the normal (default) setting

<3> This indicates that the character will be three 
times as bold as the normal (default) setting. 

<4> This indicates that the character will be four 
times as bold as the normal (default) setting. 

Table 5-2: Multi-Stroke (Bold) Values

Figure 5-10:  <01 Char> Frame

Multi- 
Stroke
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Do the following tasks to reverse a character:
1 Use the arrow keys to move the cursor to the location in the message 

where you want the character to appear.

2 Begin in Frame <01 Char> (01 Edit > 02 Edit - Char Set-Up > 01 Char). 
Refer to Figure 5-12.

3 View the current setting above <Reverse Char>. Is it set to <ON>?

• If NO, press the F2 key to change the setting to <ON>.

• If YES, continue to the next step.

4 Enter the new character into the message. The character appears in the 
display screen reversed.

Note: The next character entered will also be reversed unless you press the 
F2 key to change the setting to <OFF> before entering the character.

To Invert a Character
This procedure explains how to invert an individual character within a 
message. Inverting a character causes the character to appear upside 
down. Refer to Figure 5-13. Only new characters can be inverted; you 
cannot invert an existing character in the message. 

Do the following tasks to invert a character:

1 Use the arrow keys to move the cursor to the location in the message 
where you want the character to appear.

Figure 5-11: Reversing the Character

Character “J” 
is Reversed

Figure 5-12:  <01 Char> Frame

OFF 
Reverse 

Char.

OFF  
Invert 
Char.

Character “J” 
is Inverted

Figure 5-13: Inverting the Character
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2 Begin in Frame <01 Char>. See Figure 5-12 on page 5-17.

3 View the current setting above <Invert Char>. Is it set to <ON>?

• If NO, press the F3 key to change the setting to <ON>. 

• If YES, continue to the next step. 

4 Enter the new character into the message. The character appears in the 
display screen inverted.

Note: The next character entered will also be inverted unless you press the 
F3 key to change the setting to <OFF> before entering the character.

To Change the Character Spacing
This procedure explains how to change the character spacing of an 
individual character within a message. Changing the character space 
value makes the character gap increase by the number of vertical strokes 
used to create each space.

When you increase the character spacing value, the distance between the 
characters increases. Only new characters can have character spacing; you 
cannot change the existing characters in the message to have different 
character spacings.

Do the following to change the character spacing:

1 Use the arrow keys to move the cursor to the location in the message 
where you want the character spacing to appear.

2 Begin in Frame <01 Char> (01 Edit > 02 Edit - Char Set-Up > 01 Char). 
See Figure 5-14.

3 View the current setting above <Char Spacing>. If desired, press the 
F4 key to change the setting. The settings are 1, 2, 3, 4, 5, 6, 7, 8, and 9.

Figure 5-14:  <01 Char> Frame

Char 
Spacing
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Table 5-3 lists the character spacing settings and their descriptions.

4 Enter the new character into the message. The character appears in the 
display screen with a proportional character spacing.

Note: The next character entered has the same character spacing value 
setting as the previous character unless you press the F1 key to change the 
setting before entering the next character.

Manage Messages

To Create a Message
Do the following tasks to create a message:

1 If you require to know about the last message printed, refer to “To 
View the Last Message Printed” on page 5-21.

2 Do one of the following tasks:

a. If there is a message on the display screen, clear the message. Refer 
to “To Clear an Existing Message” on page 5-20.

b. If there is no message on the screen, continue to the next step.

Note: Before selecting a print matrix, check that the correct Editor Font 
Group and Keyboard Language have been selected. If you change the Editor 
Font Group, a power-cycle is required.

Character 
Spacing 
Setting

Description

<1> This indicates the normal (default) space setting.

<2> This indicates a character spacing of 2.

<3> This indicates a character spacing of 3.

<4> This indicates a character spacing of 4.

<5> This indicates a character spacing of 5.

<6> This indicates a character spacing of 6.

<7> This indicates a character spacing of 7.

<8> This indicates a character spacing of 8.

<9> This indicates a character spacing of 9.

Table 5-3: Character Spacing (Character Gap) Values 
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3 Choose the message format print matrix. Refer to “To Select a Print 
Matrix (Message Format)” on page 5-21 for further information. 

4 Create the desired message. You can include one or more of the 
following in the message:

• Alphabets, numbers, and special characters. Refer to “To Enter 
Text, Numbers and Toggle Values” on page 5-4.

• Inserts. Refer to “To Apply Attributes to Messages” on page 5-27.

• Characters in different orientations. Refer to “To Print Reverse 
Image Bar Codes” on page 5-69.

• Messages in different orientations. Refer to “To Print Reverse 
Image Bar Codes” on page 5-69.

5 Edit the message, if required.

6 Load the message into the printer. For further information, refer to:

• “To Store a Message” on page 5-23

• “To Recall a Stored Message” on page 5-23

• “To View a Stored Message” on page 5-24

The message is now ready to be printed. Refer to“Print a Message” on 
page 4-4 for further information on printing the message.

To Clear an Existing Message
To clear the existing message, do the following tasks:

1 Make sure that the message you want to clear appears in the display 
screen.

2 Begin in Frame <01 Edit>. See Figure 5-15 on page 5-20.

Note: To reach Frame <01 Edit>, press the Enter key until the frame appears 
on the display screen. 

3 Press SHIFT+F2 to clear the existing message from the display screen.

4 You can clear a message from any frame by pressing the backspace 
key. 

Figure 5-15:  <01 Edit> Frame
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To View the Last Message Printed
This procedure explains how to view the last message that was printed.

Note: The message that is currently appearing in the display screen (before 
performing this procedure) may not necessarily be the last message that was 
printed by the printer.

Procedure

1 Begin in Frame <01 Edit>. See Figure 5-16.

Note: To reach Frame <01 Edit>, press the ENTER key until the frame 
appears in the display screen. 

2 Press the F3 key to select <View Print>. The last message that was 
printed appears in the display screen.

3 Press the Enter key or the Esc key to go back to Frame <01 Edit> after 
you see the message.

To Select a Print Matrix (Message Format)
This procedure explains how to select the print matrix (also called 
message format) of the message. The print matrix specifies the number of 
lines in the message, as well as the size of the printed characters. Character 
size is the number of dots high by the number of dots wide of the 
character. For example, choosing a 5 x 7 SL (Single Line) print matrix 
would allow you to create a message containing one printed line which 
contains the characters that are 5 dots high by 7 dots wide.

With print matrices, keep in mind the following guidelines: 

• If a message already exists on the screen that consists of a different 
matrix than you would like, you must clear this message before you 
can select a different matrix type.

Figure 5-16:  <01 Edit> Frame

Figure 5-17: <View Print>
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• After the print matrix has been selected, you can enter characters and 
inserts into the message.

• Once a character or insert has been entered into the message, you 
cannot change the print matrix (unless you clear the message first).

To Select Print Matrix Type
The printer provides you a variety of print matrices (message formats).

The print matrix is selected in Frame <01 Font> (01 Edit > 02 Edit - Font 
Setup > 01 Font). See Figure 5-18.

In addition, there is the <Char. Size> option which is used along with the 
print matrix type. This option is used to change the size of characters 
when you are using a mixed format matrix type. If it is not possible to 
change the character size in a message (i.e. in a single line message), Frame 
<02 Edit> will leave the <Char. Size> blank.

Do the following tasks to select the print matrix for a message:

1 If a message already exists on the display screen, do the following 
tasks:

a. Navigate to the <01 Edit>.

b. Press SHIFT+ F2 to select <Clear Message>. The existing message 
disappears from the display screen.

Note: The printer will not let you change the print matrix setting unless the 
message has been cleared first.

2 Press the F5 key to go to <02 Edit>. 

3 Press the F2 key to go to <01 Font>. Refer to Figure 5-18 on page 5-22.

4 See the current setting above <Print Matrix>. If required, press the F2 
key to change the setting.

5 View the current setting above <Char. Size>. If required, press the F1 
key to change the setting. If it is not possible to change the size of the 
characters within the message, the field above the <Char. Size> 
appears blank.

6 You can now enter characters and/or inserts into the message.

Print 
Matrix

Figure 5-18: Print Matrix



Rev AA Manage Messages     5-23

Videojet 1520 Excel Operator Manual

To Store a Message
Use this feature to store a message. After you create a new message or 
change an existing message, you can choose to store that message in any 
one of 100 storage locations in the printer. 

Note: The printer can store 103 messages. 100 user saved messages and 3 are 
default messages. 

Do the following tasks to store a message

1 Begin in Frame <03 Edit> (01 Edit > 02 Edit > 03 Edit). Refer to 
Figure 5-19.

2 Make certain the message to be stored currently appears in the display 
screen.

3 Press the F1 key to select <Store Message>. The following message 
appears in the display screen:

4 Enter in an alphanumeric name, from 1 to 8 characters long.

5 Press the ENTER key. The message that appears in the display screen 
will be stored in the location entered.

To Recall a Stored Message
This procedure explains how to recall a stored message. Once you know 
the storage name of a particular message, you can recall that message so 
that it can be loaded into the printer and printed.

If you do not know the name of the message to be recalled, turn to “To 
View a Stored Message” on page 5-24 for further information.

Do the following tasks to recall the stored message:

1 Begin in Frame <03 Edit> (01 Edit > 02 Edit > 03 Edit). See Figure 5-20.

Figure 5-19:  <03 Edit> Frame

Store
Message
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2 Press the F2 key to select <Recall Message>. The following appears in 
the display screen:

3 Enter in the name of the message to be recalled. Message name cannot 
be more than 8 characters long.

4 Press the ENTER key. The message stored by that name will appear in 
the display screen.

Note: Remember that you must load the message into the printer before you 
can print the message. 

To View a Stored Message
This procedure explains how to view the messages currently stored in the 
printer memory. The printer can store up to 100 messages. You can use the 
cursors to view the contents of stored messages. The user also has the 
capability of loading and deleting messages from View Stored Messages. 
If you do not know the storage location name of a particular message, you 
can search through the storage locations message names using the arrow 
keys.

Do the following to view the stored message:

1 Begin in Frame <03 Edit> (01 Edit > 02 Edit > 03 Edit). See Figure 5-21.

Figure 5-20:  <03 Edit> Frame

Recall 
Message
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2 Press the F3 key to select <View Store>. The following screen appears 
in the display screen:

3 Use the right and left arrow keys to view the contents of all the stored 
messages.

The following guidelines apply to the arrow keys when changing the 
storage message:

Once the stored message appears in the display screen, the user can select 
SHIFT+ENTER to load that message. Another option is to select 
SHIFT+DELETE to delete the message from storage.

To Adjust the Height of a Message
You can adjust the height of a message. The message height is adjusted in 
Frame <01 Print>. See Figure 5-22.

Arrow Key Description

Press this key to increment to the next message. 

Press this key to decrement to the next message.

Table 5-4: Changing Values Using the Arrow Keys

Figure 5-21:  <03 Edit> Frame

View 
Store
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Do the following to adjust the height of the message:

1 Begin in Frame <01 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-Up > 01 Print). See Figure 5-22.

2 Press the F2 key to select <Message Height>. The following message 
appears in the display screen. 

3 Use the arrow keys to adjust the height of the printed message. The 
entry must be between from 1-100.

4 Press the ENTER key. Frame <01 Print> reappears in the display 
screen.

To Adjust the Width of a Message
You can adjust the width of the message. The message width is adjusted in 
Frame <01 Print>. Refer to Figure 5-23 on page 5-26.

• The width of the message can be adjusted if the printer is set up for 
internal, auto encoding. Refer to “Select the Encoder” on page 4-14 for 
more information on different types of encoder settings.

Do the following tasks to adjust the width of the message:

1 Begin in Frame <01 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-Up > 01 Print). See Figure 5-23.

Message 
Height

Figure 5-22:  <01 Print> Frame

Figure 5-23: Width Adjustment Setting

Message 
Width
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2 Press the F3 key to select <Message Width>. The following message 
appears in the display screen. 

3 Use the arrow keys to adjust the width of the printed message. The 
entry must be between from 0-100.

Note: As the values increase in increments of 10, the characters per inch 
increase in increments of 0.5 for the characters having width as 6 dots wide    
(font height of 5 x 7 high). Refer to Table 5-5 on page 5-27.

4 Press the ENTER key. The Frame <01 Print> reappears in the display 
screen.

Table 5-5 lists the width adjustment settings for the characters having 
width as 6 dots wide (font height of 5 x 7 high). 

To Apply Attributes to Messages
The procedures in this section show you how to create a reversed, 
inverted, or bold message, and how to adjust the height and width of a 
message.

You can create a message that is a combination of these features. For 
example, you can create a message that is both reversed and inverted at 

Width Adjustment 
Setting

Characters Per
Inch

Characters Per
Centimeter

100 7.0 2.8

90 7.5 3.0

80 8.0 3.2

70 8.5 3.4

60 9.0 3.5

50 9.5 3.7

40 10.0 3.9

30 10.5 4.1

20 11.0 4.3

10 11.5 4.5

0 12.0 4.7

Table 5-5: Width Adjustment Settings
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the same time, or you can create a message that is reversed and bold at the 
same time.

Figure 5-24 shows the frame used in this section (01 Edit > 02 Edit > 03 
Edit > 04 Edit - Print Set-Up > 01 Print > 02 Print > 03 Print).

To Change the Message Multi-Stroke (Bold)
You can change the multi-stroke (bold) value for the entire message. The 
multi-stroke (bold) setting is used to adjust the number of vertical strokes 
of drops used to create a character. As this value increases, the width of 
the character increases, making the character appear more bold.

This setting will override any change to make an individual character bold 
(made in Frame <01 Char>). Refer to “To Change the Character Multi-
Stroke (Bold)” on page 5-15 for further information.

Do the following tasks to change multi-stroke value for the entire 
message:

1 Begin in Frame <03 Print>. Refer to Figure 5-25 for information on 
accessing Frame <03 Print>.

2 Load the message into the printer. This can be an existing message, or 
you can create a new message.

3 View the current setting above <Multi-Stroke>. If desired, press the F1 
key to change the setting. The settings are 1, 2, 3, 4.

Figure 5-24:  <03 Print> Frame

Multi- 
Stroke

 Reverse 
Message

 Invert 
Message

Figure 5-25: Changing the Multi-Stroke Value of a Messages
Multi Stroke Value
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When selecting the multi-stroke level that you want your message to 
show, you can choose from the values listed in Table 5-6. 
Table 5-6 lists the multi-stroke (bold) settings and descriptions.

Note: The message will not appear bold in the display screen; however, it will 
be bold when printed.

To Reverse a Message
This procedure explains how to reverse an entire message. Reversing the 
message rotates the order of the characters, printing the last character first, 
and the first character last. Refer to Figure 5-26. 

Procedure

1 Load the desired existing message into the printer or create a new 
message and load it into the printer. Refer to “To Recall a Stored 
Message” on page 5-23.

2 Begin in Frame <03 Print>. See Figure 5-24 on page 5-28.

3 View the current setting above <Reverse Message>. Is it set to <ON>?

• If NO, press the F2 key to change the setting to <ON>.

• If YES, the message is already set to be reversed.

Multi-Stroke 
Setting

Description

1 This indicates the normal (default) setting. 

2 This indicates that the characters will be twice 
as bold as the normal (default) setting

3 This indicates that the characters will be three 
times as bold as the normal (default) setting. 

4 This indicates that the characters will be four 
times as bold as the normal (default) setting. 

Table 5-6: Multi-Stroke (Bold)

Reversed 
Message

Figure 5-26: Reversing the Message - Example

Normal 
Message
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Note: Setting Reverse Message to <ON> only reverses the order in which 
the characters are printed.

4 View the current settings above <Reverse All Ch>. Is it set to <ON>?

• If NO, press F4 key to change the setting to <ON>.

• If YES, it is already set to produce the mirror image of the original 
message.

Note: The message will not appear reversed in the display screen, however it 
will be reversed when printed.

Note: When the product is moving past the printhead from left to right, it is 
necessary to reverse all characters and reverse the entire message for the code 
to print correctly on the product.

To Invert a Message
This procedure explains how to invert an entire message. Inverting a 
message flips each character 180 degrees, producing an “upside-down” 
message. Refer to Figure 5-27 on page 5-30 for an example.

Inverted messages are typically used when the printhead has been 
positioned upside down in relation to the product, or the product is 
upside down, but you do not wish to print upside down. This enables the 
message to be printed in the proper direction on the product.

This setting will override any change made to invert the character 
individually (from Frame <01 Char>). Refer to “To Invert a Character” on 
page 5-17 for further information.

The setting does not override any character setting already set in the 
message. For example, if a single character is inverted in a message and 
the message is inverted, the character will appear the correct way up itself.

Inverted 
Message

Figure 5-27: Inverting the Message - Example

Normal 
Message
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Procedure

1 Load the desired (existing) message into the printer or create a new 
message and load it into the printer.

2 Begin in Frame <03 Print>. Refer to Figure 5-24 on page 5-28.

3 View the current setting above <Invert Message>. Is it set to <ON>?

• If NO, press the F3 key to change the setting to <ON>. This will 
invert the entire message.

• If YES, the message is already set to be inverted.

Note: The message will not appear inverted in the display screen, however it 
will be inverted when printed.

Reversed and Inverted Message

Figure 5-28 shows an example of a message which is reversed, then 
inverted. 

To Set 5 x 7 SL Tower
This procedure shows you how to use the 5 x 7 SL Tower function. This 
allows you to print a message onto a substrate with the effect of printing 
in a vertical direction, rather than the usual horizontal direction. This 
application is useful for marking wires and cables. See Figure 5-29.

Figure 5-28: Reversed and Inverted Message

Reversed Message Reversed Message 
Inverted
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Note: The tower font is available only in the 5 x 7 SL print matrix. It will have no 
effect on other print matrices.

The tower print font rotates each character of the normal 5 x 7 font 90 degrees 
counterclockwise. Therefore, the print matrix actually becomes 7 drops wide by 5 
drops high, and the characters are printed “sideways.” Refer Figure 5-30.

Do the following tasks to enable 5X7 SL Tower function:

1 Load the desired existing message into the printer or create a new 
message and load it into the printer.

2 Begin in Frame <06 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-Up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 Print). 
See Figure 5-31.

Figure 5-29: Sample Application for Tower Font Printing. 

Figure 5-30: Tower Printing Example

Message Printed in 5 x 7 SL Tower (Vertical Direction) 

Message Printed in Standard Horizontal Direction
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3 View the current setting above <5 x 7 SL Tower>. Is it set to <ON>?

•  If NO, press the F3 key to change the setting to <ON>. This will 
print the entire message in the tower font.

• If YES, the message is already set to print in the tower font.

4 Press the ENTER key to return to Frame <01 Print>.

Note: The message will not appear in the tower font in the display screen; 
however, it will print in the tower font orientation.

Manage Inserts
This section describes the procedures you must follow to add inserts into 
messages. 

An insert is defined as a segment of information that is added into the 
message and automatically changed by the printer as messages are 
printed. 

You can set the language for the alpha inserts at <Date Language> on <01 
Locale>. 

There are three types of inserts, Type 1, 2, and 3.

Table 5-7 lists the types of inserts and their characteristics.

Insert Type Insert Characteristics

Type 1 Inserts where the parameters (information that appears in the 
message) are defined by you, not by the printer's internal 
clock. The insert is updated according to the settings made 
during set-up.

Type 2 Inserts where the parameters (information which appears in 
the message) are determined by the current reading of the 
printer's internal clock. The printer automatically updates the 
insert as the printer's internal clock changes.

Table 5-7: Insert Types 

Figure 5-31:  <06 Print> Frame

5X7 SL
Tower
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With some inserts you can include as many (of that type) in the message as 
space allows, whereas with other inserts you can have only one per 
message.

Refer to Table 5-8 on page 5-34 for a listing of each insert that you can 
place into a message.

When you are finished adding inserts into a message, you must load the 
message into the printer before you can print it. Otherwise, the insert(s) 
added will not appear in the message. For further information, refer to:

• “To Store a Message” on page 5-23

• “To Recall a Stored Message” on page 5-23

• “To View a Stored Message” on page 5-24

Table of Inserts
Refer to Table 5-8 below for a complete list of the:

• Number of inserts available

• Types of inserts

• Maximum number of inserts of a type that you can insert in a single 
message

• Page references for specific information on that insert

Note: SLO = Space Limitations Only (meaning you can add as many of this type 
of insert into the message as space allows).

Type 3 Inserts which are a combination of Type 1 and Type 2. With 
these types of inserts, you need to define one or more 
parameters (information which appears in the message) before 
inserting them into the message. However, the insert is 
automatically updated as the printer's internal clock changes. 

Insert Max. Digits 
per Insert

Type Max. per 
Message*

Page

Alpha Hour 1 2 SLO 5-42

Alpha Month 3 2 SLO 5-46

Hour of Day 2 2 SLO 5-39

Table 5-8: Insert Information

Insert Type Insert Characteristics

Table 5-7: Insert Types (Continued)
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*One Serializer 1 insert and one Serializer 2 insert can be added to a message. 
Multiple copies of these same serializer inserts can be added to the same message 
depending upon the space allowed in the message.

**BLO = Bar code Limitations Only (meaning certain bar codes have size and 
data content limitations)

Serializer

To Insert a Serializer
You can insert a serializer into a message.

A serializer is an alphanumeric value which is added into a message and 
is automatically changed by the printer as product detect signals are 

Minute of Hour 2 2 SLO 5-40

Hour of Week 3 2 SLO 5-41

Week of Year 2 2 SLO 5-41

Month of Year 2 2 SLO 5-44

Day of Month 2 2 SLO 5-45

Year 2 SLO 5-45

Julian Date 3 2 SLO 5-46

Expiration Alpha Month 3 2 SLO 5-52

Expiration Month of Year 2 3 SLO 5-49

Expiration Day of Month 2 3 SLO 5-47

Expiration Year 2 3 SLO 5-49

Expiration Julian Date 3 3 SLO 5-51

Serializer 8 1 *2 5-35

Timer 4 3 1 5-54

Programmable Shift 
Timer

1 3 SLO 5-66

Remote Data 32 1 1 5-57

s Message 
length

1 SLO 5-72

Bar Codes **BLO 3 SLO 5-59

Insert Max. Digits 
per Insert

Type Max. per 
Message*

Page

Table 5-8: Insert Information



5-36     Manage Inserts Rev AA

Videojet 1520 Excel Operator Manual 

received (products are printed upon). It is a counter that will update as 
messages are printed. You may add two separate serializer inserts 
(serializer 1 and serializer 2) per message.

Serializer parameters are defined by you, rather than the printer's internal 
clock. Before inserting a serializer into the message, you must set the 
following serializer parameters for either serializer used.

Table 5-9 lists the serializer insert parameters.

Once inserted into the message, the serializer will be updated (according 
to the parameter settings) as messages are printed. The serializer in the 
display screen will not change as the serializer is updated; however, it will 
change in the printed message. Serializers will store their current values 
unless the F4<Print Message> button is pressed, which resets the 
serializer.

Parameters Explanation

Start Value This is the first value to be printed. The value must be less than 
the max count (ending value) and from 00000000--99999999 
(if content is numeric). The starting value determines the 
alphanumeric arrangement and length of the end value. 
Starting value can also be configured for uppercase and 
lowercase alpha mode.

Max Count
(End Value)

The value that the counter reaches at the end of the count. The 
value must be greater than the starting value, and from 
00000001--99999999 (if starting value is numeric). End value 
length and alphanumeric arrangement are dependent upon the 
Start Value configuration. The value can also be configured in 
an uppercase and lowercase alpha mode.

Count Up/
Down

Set the serializer to <UP> to update the value in a positive 
(upward) direction or to <DOWN> to update the value in a 
negative (downward) direction.

Constant Number by which the counter is incremented or decremented. 
The setting must be from 1--99.

Repeat 
Count

Set the number of times you want to print the message with the 
same serializer value before updating the value. The setting 
must be from 1--9999.

Off 
Increment 
Serializer

 5. Set the second serializer to increment after the first serial-
izer has rolled over (reached its End value).

Current 
Value

Allows the Starting Value to be changed to a current value. 
Changes to current value also need to match the starting value 
alphanumeric arrangement and length.

Current 
Repeat

Allows changing the Repeat Count value to a current value. 
The setting ranges from 1-9999.

Table 5-9: Serializer Insert Parameters
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Do the following tasks to insert a serializer into a message:

1 Begin in Frame <01 Serial 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Serializer > 01 Serial > 02 Serial - Set Up Serial 1 > 01 Serial 1). Refer to 
Figure 5-32 on page 5-37.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the serializer to appear.

3 Press the F1 key to select <Start Value>. The following appears in the 
display screen:

02 
Serial

Figure 5-32:  <02 Serial> Frame

01 
Serial 1

02 
Serial 1

01 
Serial 2

02 
Serial 2

03 
Serial 1

03 
Serial 2
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4 Enter the starting value.The starting value determines the 
alphanumeric arrangement and length of the end value. In 
alphanumeric mode, 0=a or 0=A and 9=j or 9=J

Note: When entering the starting value, you may enter letters instead of 
numbers.

5 Press the ENTER key. Frame <01 Serial 1> reappears in the display 
screen.

6 View the current setting above <Count Up/Down>. If desired, press 
the F2 key to change the setting. (Settings: Up, Down).

7 Press the F3 key to select <Constant>. The following appears in the 
display screen:

8 Enter the constant. The entry must be from 1-99.

9 Press the ENTER key. Frame <01 Serial 1> reappears in the display 
screen.

10 Press the F5 key to go to Frame <02 Serial 1>. Refer to Figure 5-32 on 
page 5-37.

11 Press the F1 key to select End Value. The following appears in the 
display screen:

12 Enter the end value (the value the serializer will either stop at or 
rollover). The end value length and alphanumeric arrangement must 
match the starting value. In alphanumeric mode, 0=a or 0=A and 9=j 
or 9=J.

Note: If the starting value is 0AA85, then the ending value could be 
something like 9ZZ99. Both the starting and the ending values need the same 
alphanumeric arrangement and length.

13 Press the ENTER key. Frame <02 Serial 1> reappears in the display 
screen.

14 Press the F3 key to select <Repeat Count>. The following appears in 
the display screen:
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15 Enter the repeat count.

16 Press the ENTER key. Frame <02 Serial 1> reappears in the display 
screen.

17 Press the F4 key to select <Insert Serial>. The starting value of the 
serializer appears in the message.

18 Press the F5 key to go to Frame <03 Serial 1>.

19 To insert a second serializer in the message, repeat steps 1 through 18 
but begin in Frame <01 Serial 2>.

20 Press the F4 key and change the <Increment Serializer> value to ON.

Clock

To Insert the Hour of the Day
This procedure explains how to place an hour of day insert into a message. 
The hour of day insert is a two-digit number representing the current hour 
of the day in a 24-hour format.The value for this insert is determined by 
the printer's internal clock, and is updated as the internal clock changes.

 Table 5-10 lists the hour of day inserts.

Value Time of Day Value Time of Day

00 12:00 a.m. 
(midnight)

12 12:00 p.m. 
(noon)

01 1:00 a.m. 13 1:00 p.m.

02 2:00 a.m. 14 2:00 p.m.

03 3:00 a.m. 15 3:00 p.m.

04 4:00 a.m. 16 4:00 p.m.

05 5:00 a.m. 17 5:00 p.m.

06 6:00 a.m. 18 6:00 p.m.

07 7:00 a.m. 19 7:00 p.m.

08 8:00 a.m. 20 8:00 p.m.

09 9:00 a.m. 21 9:00 p.m.

Table 5-10: Hour of Day Insert Values  
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Do the following tasks to place an hour of a day insert into a message.

1 Begin in Frame <01 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock). Refer to Figure 5-33.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F1 key to select <Insert Hour>. The insert appears in the 
message.

To Insert Minute
You can place minute inserts into messages. The minute insert is a two-
digit number representing the current minute. The value of this insert is 
determined by the printer's internal clock, and is updated as the printer's 
internal clock changes.

Do the following tasks to place the insert minute into a message:

1 Begin in Frame <01 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock).  

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

10 10:00 a.m. 22 10:00 p.m.

11 11:00 a.m. 23 11:00 p.m.

Value Time of Day Value Time of Day

Table 5-10: Hour of Day Insert Values (Continued) 

Figure 5-33:  <01 Clock> Frame 

Insert 
Hour

Figure 5-34:  <01 Clock> Frame

Insert 
Minute
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3 Press the F2 key to select <Insert Minute>. The insert appears in the 
message.

To Insert the Hour of the Week
This procedure explains how to place an hour of the week insert into a 
message. The hour of the week insert is a three-digit number representing 
the current hour of the week. A value of 001 indicates the first hour of the 
week, and a value of 168 indicates the last hour of the week.

The value for this insert is determined by the printer's internal clock and 
the user entry made in “Set the Programmable Date Roll Over” on 
page 4-22. Hour of the Week Insert is updated as the printer's internal 
clock changes.

Do the following tasks to insert the hour of the week into the message:

1 Begin in Frame <01 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock). Refer to Figure 5-35.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F3 key to select <Insert HR/WK>. The insert appears in the 
message.

To Insert the Week of the Year 
You can insert the week of the year insert into a message. The week of the 
year insert is a two-digit number representing the current week of the 
year. A value of 01 indicates the first week of the year, and a value of 53 or 
54 indicates the last week of the year.

The value for this insert is determined by the printer's internal clock and 
the entries made in “Set Week of the Year and Hour of the Week” on 
page 4-20. Week of the Year is updated as the printer's internal clock 
changes.

Do the following tasks to insert hour of the week into the message:

1 Begin in Frame <01 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock). See Figure 5-36.

Figure 5-35:  <01 Clock> Frame

Insert 
HR/WK
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2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F4 key to select <Insert WK/YR>. The month appears in the 
message.

To Insert the Work-Shift Code
Do the following tasks to insert your work-shift code into a message:

1 Begin in Frame <02 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock > 02 Clock). See Figure 5-37.

2 Press the F1 key to select <Insert Shift>. Your work-shift code is now 
inserted at the current location of the cursor.

3 Repeat the Set-up Procedure and Step 1 of this procedure for every 
work-shift code you wish to enter.

To Insert Alpha Hour
This procedure explains how to place an Alpha Hour insert into a 
message. The Alpha Hour insert is a one-digit character representing the 
current hour of the day in a 24-hour format. The character (A-X) for each 
hour is fixed and cannot be changed. 

The value for this insert is determined by the printer's internal clock, and 
is updated as the internal clock changes.

Figure 5-36:  <01 Clock> Frame 

Insert 
WK/YR

Insert
Shift

Figure 5-37: Inserting a Work-shift Code into a Message
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Table 5-11 lists the alpha hour value inserts.

Do the following tasks to place an alpha hour insert into a message:

1 Begin in Frame <02 Clock> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Clock > 01 Clock > 02 Clock). See Figure 5-38.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F2 key to select <Insert Alp. Hour>. The insert appears in the 
message.

Value Time of Day Value Time of Day

A 12:00 a.m. (midnight) M 12:00 p.m. (noon)

B 1:00 a.m. N 1:00 p.m.

C 2:00 a.m. O 2:00 p.m.

D 3:00 a.m. P 3:00 p.m.

E 4:00 a.m. Q 4:00 p.m.

F 5:00 a.m. R 5:00 p.m.

G 6:00 a.m. S 6:00 p.m.

H 7:00 a.m. T 7:00 p.m.

I 8:00 a.m. U 8:00 p.m.

J 9:00 a.m. V 9:00 p.m.

K 10:00 a.m. W 10:00 p.m.

L 11:00 a.m. X 11:00 p.m.

Table 5-11: Alpha Hour Insert Values 

Figure 5-38:  <02 Clock> Frame

Insert   
Alp. Hour
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Date

To Insert Month
You can place month insert in messages. The month insert is a two-digit 
number representing the current month of the year. The value for this 
insert is determined by the printer's internal clock, and is updated as the 
printer's internal clock changes.

Table 5-12 lists the values of month inserts.

Do the following tasks to insert the month into the message:

1 Begin in Frame <01 Current> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Current Dates > 01 Current). Refer to Figure 5-39.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F1 key to select <Insert Month>. The insert appears in the 
message in two-digit format.

Value Month Value Month

01 January 07 July

02 February 08 August

03 March 09 September

04 April 10 October

05 May 11 November

06 June 12 December

Table 5-12: Month Insert Values

Figure 5-39:  <01 Current> Frame

Insert 
Month
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To Insert Day of the Month
You can insert the day of the month into a message. The day of the month 
insert is a two-digit number representing the current day of the month. 
The value for this insert is determined by the printer's internal clock, and 
is updated as the printer's internal clock changes.

Do the following tasks to insert the day of the month:

1 Begin in Frame <01 Current> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Current Dates > 01 Current). See Figure 5-40 on 
page 5-45.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F2 key to select <Insert Day>. The insert appears in the 
message in two-digit format.

To Insert Year
You can insert the year into a message. The year insert is a two-digit 
number representing the last two numbers of the current year.

The value for this insert is determined by the printer's internal clock, and 
is updated as the printer's internal clock changes.

Example: The insert for the year “2007” will appear as “07”.

Procedure

1 Begin in Frame < 01 Current > (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Current Dates > 01 Current). See Figure 5-41.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F3 key to select <Insert Year>. The year is inserted in the 
message in two-digit year format. 

Insert 
Day

Figure 5-40:  <01 Current> Frame
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To Insert Julian Date
You can insert Julian date into a message. The Julian date insert is a three-
digit number representing the current day of the year. A value of 001 
indicates the first day of the year, and a value of 365 or 366 indicates the 
last day of the year.

The value for this insert is determined by the printer's internal clock, and 
is updated as the printer's internal clock changes.

Do the following tasks to insert julian date:

1 Begin in Frame <01 Current> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Current Dates > 01 Current). See Figure 5-42.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F4 key to select <Insert Julian>. The insert appears in the 
message.

To Insert Alpha Month
This procedure explains how to place an Alpha Month insert into a 
message. The Alpha Month insert is a three-digit character representing 
the current month of the year. The characters (Jan. - Dec) for each month 
are fixed and cannot be changed. 

Insert 
Year

Figure 5-41: <01 Current> Frame

Insert 
Julian

Figure 5-42:  <01 Date> Frame
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The value for this insert is determined by the printer's internal clock, and 
is updated as the internal clock changes.

Table 5-13 lists the alpha month insert values.

Do the following tasks to place an alpha month insert into a message:

1 Begin in Frame <02 Current> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Current Dates > 01 Current > 02 Current). Refer to 
Figure 5-43.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F1 key to select <Insert Alp. Month>. The insert appears in 
the message.

To Insert Expiration Day of the Month 
You can insert expiration day of month into a message. The expiration day 
of month insert is a two-digit number representing the day of the month in 
which a product will expire.

Note: You must set the offset units and values before you set up the expiry dates. 
The offset settings work for all the date inserts under Expiry Date 1.

Note: To set the date of expiry, you must set the offset value for the units (days, 
months, or years) from the current date (depends on the internal clock of the 
printer). The printer maintains the expiration day (based on the offset unit and 

Value Month of Year Value Month of Year

JAN January JUL July

FEB February AUG August

MAR March SEP September

APR April OCT October

MAY May NOV November

JUN June DEC December

Table 5-13: Alpha Month Insert Values 

Figure 5-43:  <02 Current> Frame

Insert    
Alp. Month
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value) from the current date. Also, you can add two expiration dates (Expiry Date 
1 and Expiry Date 2) in a message.

Example: If the current date is January 24th and you set the expiration 
date of the product to be 14 days from the current date, then the printer 
will print 07 for the expiration day of year insert. The value 07 represents 
February 7 (which is the day of the month 14 days from the current date).

Do the following tasks to insert the expiration day of the month:

1 Begin in Frame <01 Exp 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Expiry Dates 1 > 01 Exp 1). Refer to Figure 5-44.

2 Press the F5 key to go to Frame <02 Exp 1>.

3 Press the F4 key to select <Exp Date Offset>.

4 Enter the number of days that can pass before the product expires.The 
entry must be between 1-2048 (2048 days is about 5½ years).

Figure 5-44:  Frame <01 Exp 1> and <01 Exp 2>

Exp Date 
Offset

Insert
Exp Day

Exp Date 
Offset

Insert
Exp Day
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5 Press the ENTER key to return to <01 Exp 1>.

6 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

7 Press the F2 key to select <Insert Exp Day>. The insert appears in the 
message.

8 To add a second expiration month insert, repeat steps 1 through 8 but 
begin in Frame <01 Date -Expiry Dates 2>.

To Insert Expiration Month of the Year
You can insert expiration month of the year insert into a message. The 
expiration month of year insert is a two-digit number representing the 
month of the year in which a product will expire.

Note: You must set the offset units and values before you set up the expiry dates. 
The offset settings work for all the date inserts under Expiry Date 1.

Note: To set the date of expiry, you must set the offset value for the units (days, 
months, or years) from the current date (depends on the internal clock of the 
printer). The printer maintains the expiration day (based on the offset unit and 
value) from the current date. Also, you can add two expiration dates (Expiry Date 
1 and Expiry Date 2) in a message.

Example: If the current date is January 24th and you set the expiration 
date of the product to be 14 days from the current date, the printer will 
print 02 for the expiration month of year insert. The value 02 represents 
the month of February (which is the month 14 days from the current date).

Do the following tasks to insert expiration month of the year:

1 Begin in Frame <01 Exp 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Expiry Dates 1 > 01 Exp 1). Refer to Figure 5-47 on 
page 5-54.

2 Press the F1 key to select <Insert Exp Mon.>. The insert appears in the 
message.

3 To add a second expiration month insert, begin in Frame <01 Date -
Expiry Dates 2>.

To Insert Expiration Year
You can insert expiration year into a message. The expiration year insert is 
a two-digit number representing the year in which a product will expire.

Note: You must set the offset units and values before you set up the expiry dates. 
The offset settings work for all the date inserts under Expiry Date 1.
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Note: To set the date of expiry, you must set the offset value for the units (days, 
months, or years) from the current date (depends on the internal clock of the 
printer). The printer maintains the expiration day (based on the offset unit and 
value) from the current date. Also, you can add two expiration dates (Expiry Date 
1 and Expiry Date 2) in a message.

Example: If the current date is November 24th, 2007 and you set the 
expiration date of the product to be 60 days from the current date, then the 
printer will print 08 for the expiration year insert. The value 08 represents 
the year 2008 (60 days from the current date).

Figure 5-45:  Frame <01 Exp 1> and <01 Exp 2>

Exp Date 
Offset

Insert
Exp Year

Insert
Exp Year

Exp Date 
Offset
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Do the following to insert expiration year into a message:

1 Begin in Frame <01 Exp 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date -Expiry Dates 1 > 01 Exp 1). See Figure 5-45.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F3 key to select <Insert Exp Year>. The insert appears in the 
message.

4 To add a second expiration month insert, begin in Frame <01 Date -
Expiry Dates 2>.

To Insert Expiration Julian Date
This procedure explains how to place an expiration julian date insert into a 
message. The expiration julian date insert is a three-digit number 
representing the day of the year in which a product will expire. A value of 
001 indicates the first day of the year, and a value of 365 (or 366) indicates 
the last day of the year.

Note: You must set the offset units and values before you set up the expiry dates. 
The offset settings work for all the date inserts under Expiry Date 1.

Note: To set the date of expiry, you must set the offset value for the units (days, 
months, or years) from the current date (depends on the internal clock of the 
printer). The printer maintains the expiration day (based on the offset unit and 
value) from the current date. Also, you can add two expiration dates (Expiry Date 
1 and Expiry Date 2) in a message.

Example: If the current Julian date is 012 (January 12) and you set the 
expiration date of the product to be 14 days from the current date, then the 
printer will print 026 for the expiration Julian date insert. The value 026 
represents January 26 (which is 14 days from the current date).
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Do the following tasks to insert expiration Julian Date:

1 Begin in Frame <01 Exp 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date - Expiry Dates 1 > 01 Exp 1). Refer to Figure 5-46.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F4 key to select <Insert Exp Julian>. The insert appears in the 
message.

4 To add a second expiration julian date insert, begin in Frame <01 Date 
-Expiry Dates 2>.

To Insert Expiration Alpha Month
This procedure explains how to place an expiration alpha month insert 
into a message. The expiration alpha month insert is a three-digit character 
representing the month of the year in which a product will expire. The 
characters (Jan. - Dec) for each month are fixed and cannot be changed.

Note: You must set the offset units and values before you set up the expiry dates. 
The offset settings work for all the date inserts under Expiry Date 1.

Note: To set the date of expiry, you must set the offset value for the units (days, 
months, or years) from the current date (depends on the internal clock of the 

Figure 5-46:  <01 Exp 1> and <01 Exp 2> Frame

Exp Date 
Offset

Insert
Exp Julian

Exp Date 
Offset

Insert
Exp Julian
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printer). The printer maintains the expiration day (based on the offset unit and 
value) from the current date. Also, you can add two expiration dates in a message.

Table 5-14 lists the values for expiration alpha month insert.

Example: If the current date is January 24 and you set the expiration date 
of the product to be 70 days from the current date, the printer will print 
APR for the expiration month of year insert. The month April (APR) is the 
month that is 70 days from the current date.

Do the following tasks to insert the expiration alpha month:

1 Begin in Frame <02 Exp 1> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Date > 01 Date -Expiry Dates 1 > 01 Exp 1 > 02 Exp 1). See Figure 5-47.

Value Month of the Year Value Month of the Year

JAN January JUL July

FEB February AUG August

MAR March SEP September

APR April OCT October

MAY May NOV November

JUN June DEC December

Table 5-14: Expiration Alpha Month Insert Values
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2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F1 key to select <Insert Exp Alp. Mon.>. The insert appears 
in the message.

4 To add a second expiration month insert, begin in Frame <01 Date -
Expiry Dates 2>.

Timer

To Insert Timer
You can place a timer into a message. You can use only one timer insert 
per message.

A timer insert is a numeric or alphabetic representation (or a combination 
of both) of the time of the day. This is different from the hour and minute 
inserts in the sense that the time can be disguised as a “code.” This keeps 
the information confidential so that it can be understood only by those 
who know the code.

Figure 5-47:  <02 Exp1> and <02 Exp 2>Frame

Ins. Exp.  
Alp. Month

Exp Date 
Offset

Ins. Exp.  
Alp. Month
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Insert
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This insert is still generated by the printer's internal clock; however, you 
must set the parameters before inserting it into the message. The printer 
will automatically update the insert (according to the setting made in the 
<Update Interval> option) as the printer's internal clock changes.

Note: With the timer select set to 2, this insert operates as a counter that prints 
the number of time intervals that have elapsed in a day.

If the timer select is set to 4, this insert operates as a timer that prints the time of 
day at a specified interval.

Table 5-15 lists the timer insert parameters.

Note: Since an insert that is to be updated every one minute will provide a 
number greater than two digits (because there are more than 99 minutes in a day), 
the printer will not allow you to set the interval to 1 when using a two-digit 
insert.

Timer Example: If the printer's internal clock shows the current time of 
the day as 8:45 a.m., and the timer parameters are set to the following:

<Timer Select> = 4

<Update Interval> = 30

<Timer Format> Parameters:

• <Char. 1 Code> is set to an alphabetic character

• <Char. 2 Code> is set to a digit

Parameters Explanation

Timer Select Choose the total number of digits or characters that you want to 
have in the insert. You have two choices available:

• Two (2)
• Four (4)

Timer 
Format

Choose if you want each digit in the insert to remain as a digit 
or appear as an alphabetic character (representing that digit).

• This can be selected for each digit individually.
• Use to code the time by substituting digits with alphabetic 

characters.
Character/digit cross-reference:
A=0 B=1 C=2 D=3 E=4
F=5 G=6 H=7 I=8 J=9

Update 
Interval

Choose the interval (in minutes) of when the insert will be 
updated. Your selections are:

• 15, 30, or 60 minutes for a two-digit insert 
• Every minute or every 15, 30, or 60 minutes for a four-digit 

insert

Table 5-15: Timer Insert Parameters 
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• <Char. 3 Code> is set to an alphabetic character

• <Char. 4 Code> is set to a digit

The insert in this example will appear in the message as <A8D0>. This can 
be decoded as 0830 (08:30 a.m. using a 24-hour clock) since A=0 and D=3. 
The following is a cross-reference of alphabetic characters to digits 
(assigned by the printer):

A=0 B=1 C=2 D=3 E=4

F=5 G=6 H=7 I=8 J=9

Since the <Update Interval> is set to 30 (meaning every 30 minutes), the 
insert will not be updated again until the time reaches 9:00 a.m. At that 
point, the insert will read <A9A0> which is decoded as 0900 (9:00 a.m. 
using a 24-hour clock). The timer insert will be updated every 30 minutes.

Procedure

1 Begin in Frame <01 Timer> (01 Edit > 02 Edit - Inserts > 01 Insert - 
Timer > 01 Timer). See Figure 5-48.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 View the current setting above <Timer Select>. If desired, press the F1 
key to change the setting. (Settings: 2, 4.)

4 View the current setting above <Update Interval>. If desired, press 
the F3 key to change the setting. (Settings: 1, 15, 30, 60).

Note: If the <Timer Select> option is set to 2, the printer will not allow 1 as 
one of the setting choices for the <Update Interval> option.

5 Press the F2 key to select <Timer Format>. The Frame <01 Format> 
appears in the display screen. Refer to Figure 5-48 on page 5-56.

Figure 5-48:  <01 Timer> Frame

Timer
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Note: If the <Timer Select> option is set to 2, the options <Char 1 Code> and 
<Char 2 Code> will be inactive (since it is only a two-digit insert). If set to 4, 
all of the options in the frame will be active.

6 View the current setting located above each of the active options in 
Frame <01 Format>. If you want to change the setting from a digit to 
an alphabetic character (or vice versa), press the function key located 
below that option.

7 Press the ENTER key. Frame <01 Timer> appears in the display 
screen.

8 Press the F4 key to select <Insert Timer>. The timer insert appears in 
the message.

To Insert Remote Data
This procedure explains how to place a remote data insert into a message. 
A remote data insert is used to download fixed or variable information 
from a host personal computer (PC) into the message.

This insert can be used only if a host PC has been connected to the printer 
using an RS-232 or RS-485 serial interface.

You can use only one remote data insert per message.

Procedure

1 Begin in Frame <01 Remote> (01 Edit > 02 Edit - Inserts > 01 Insert > 
02 Insert - Remote Data > 01 Remote). Refer to Figure 5-49.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 Press the F1 key to select <Buffer Size>. The following appears in the 
display screen:

Figure 5-49: Accessing Frame <01 Remote>

Buffer
Size

Insert
Remote
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4 Enter the buffer size. The entry must be from 1 to 32.

The buffer size is the maximum number of characters that appear in 
the longest line of the remote.

Example: The longest line is eight characters. You must enter eight as 
the buffer size (carriage return is not required).

5 Press the ENTER key. Frame <01 Remote> reappears in the display 
screen.

6 Press the F2 key to select <Insert Remote>. The insert will appear in 
the message as “insert remote symbols”. Refer to Figure 5-50 on 
page 5-58.

An insert remote symbol will appear for each character entered in 
<Buffer Size>. If the <Buffer Size> option is set to 8, eight insert 
remote symbols will appear in the message where the remote 
information will be printed. Refer to Figure 5-50.

Figure 5-50: Message with a Remote Insert 

Message before insert is added:

Message after insert was added:
(buffer size entered was 8)

Remote Symbol
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To Insert Bar Codes
You can insert a bar code into a message. There are eight types of bar code 
inserts you can add into the message.

Bar code can be inserted in a message only if the message matrix size is 
greater than or equal to 7 x 9 high. Human readable bar code can be 
turned on, only if the matrix size is greater than 16 high.

Table 5-16 lists the bar code types and their descriptions.

You can use as many bar code inserts in the message as space allows.

Fixed length bar codes that do not have the correct amount of data added, 
will have zeroes appended to the beginning of the bar code value.

Correct checksums are automatically included in each bar code. Code 128 
and EAN 128 bar codes do not display the checksum, but their checksum 
values are encoded in the printed bar pattern.

To activate the human readable bar code, press the F1 key above the 
selection <Bars W/ Charac.> until it reads “Below”.

Note: The fully constructed bar code image can be seen in the editor display as the 
data is entered.

Note: Whether <Bars W/ Charac.> is None or Below, human readable data will 
always be displayed above the bar code in the editor. This allows the user to verify 
the bar code content. However, the printed bar code will have either printed 
human readable data below, or not at all, depending upon the <Bars W/ Charac.> 
setting.

Bar Code Type Description

3 of 9 Can be used for both uppercase alphabetic and numeric 
characters. 

2 of 5 Interleaved 
(2 of 5I)

Can be used for an even number of numeric characters. 

EAN-8 Can be used for numeric characters only.

EAN-13 Can be used for numeric characters only.

UPC-A Can be used for numeric characters only.

UPC - E Can be used with numeric characters only

Code 128 Can be used for both alphabetic and numeric characters. 

EAN 128 Can be used for both alphabetic and numeric characters. 

2D Data Matrix Can be used for both alphabetic and numeric characters. 

Table 5-16: Bar Code Types
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While adding an insert to a bar code, verify if the insert contains the 
proper data content and the length required for the selected bar code. To 
delete a bar code, place the cursor inside the bar code and press the F4 
<Delete Barcode> located in Frame <04 Barcode>.

Note: Bar codes can be configured to print in a reverse image bar code mode 
where bars, for a normal bar code, are now printed as spaces, and spaces for a 
normal bar code, are now printed as bars.

To Insert 3 of 9 or 2 of 5I Bar Codes
Do the following tasks to insert 3 of 9 or 2 of 5I Bar Codes: 

1 Begin in Frame <01 Barcode> (01 Edit > 02 Edit - Inserts > 01 Insert > 
02 Insert - Bar Code > 01 Barcode). See Figure 5-53.

2 Use the arrow keys to move the cursor to the location in the message 
where you want the insert to appear.

3 You can now choose to add a 3 of 9 or 2 of 5I bar code into the 
message. The length of these bar codes is only dependent upon the 
message length:

• To insert a 3 of 9 bar code, press the F3 key to select <Insert 3 of 9>. 
Enter the desired uppercase alphanumeric data for this bar code. In 
the editor, the bar code image for that data will be displayed.

• To insert a 2 of 5I bar code, press the F4 key to select <Insert 2 of 
5I>. Enter the desired numeric data for this bar code. In the editor, 
the bar code image for that data will be displayed.

4 Use the appropriate keys on the keyboard to enter the information 
that is to appear in the bar code.

Note: The 2 of 5I code requires an even number of digits entered. Uneven 
entries would have a “0” added to the beginning of the data to create an even 
numbered code. For example, a code of “12345” would print as “012345” 
(not including the checksum). 

None
Bars W/
Charc.

Figure 5-51:  <01 Barcode> Frame
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To Insert EAN-8 and EAN-13 Bar Codes
Do the following tasks to insert EAN-8 or EAN-13 Bar Codes: 

1 Begin in Frame <02 Insert> (01 Edit > 02 Edit - Inserts > 01 Insert > 02 
Insert). See Figure 5-53.

2 Press the F2 key to select <Bar Code>. Then press the F5 key. Frame 
<02 Barcode> appears in the display.

3 Use the arrow keys to move the cursor to the location in the message 
where you want the bar code insert to appear. 

4 You can now choose to add a bar code into the message: 

To insert an EAN-13 bar code, press the F1 key to select <Insert EAN-
13>. Enter 12 numeric digits for this bar code (the 13th digit checksum 
will be automatically calculated). In the editor, the bar code image for 
that data will be displayed. Refer to Figure 5-54.

To insert an EAN-8 bar code, press the F2 key to select <Insert EAN-
8>. Enter seven numeric digits for this bar code (the 8th digit 
checksum will be automatically calculated). In the editor, the bar code 
image for that data will be displayed. Refer to Figure 5-54.

Figure 5-52: Messages with Bar Code Inserts

3 of 9 Bar Code

2 of 5I Bar Code

Figure 5-53:  <02 Barcode> Frame
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5 Use the appropriate keys on the keyboard to enter the information 
which is to appear in the bar code. 

To Insert UPC-A and UPC-E Bar Codes
Do the following to insert UPC-A and UPC-E Barcodes:

1 Begin in Frame <02 Insert> (01 Edit > 02 Edit - Inserts > 01 Insert > 02 
Insert). Refer to Figure 5-55.

2 Press the F2 key to select <Bar Code>. Then press the F5 key. Frame 
<02 Barcode> appears in the display.

3 Use the arrow keys to move the cursor to the location in the message 
where you want the bar code insert to appear. 

4 You can now choose to add a bar code into the message.

Figure 5-54: Messages with Bar Code Inserts
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Figure 5-55:  <04 Barcode> Frame
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To insert an UPC-A bar code, press the F3 key to select <Insert UPC-
A>. Enter the 11 numeric digits for this bar code (the 12th digit 
checksum will be automatically calculated). In the editor, the bar code 
image for that data will be displayed.

To insert an UPC-E bar code, press the F4 key to select <Insert UPC-
E>. Enter the 7 numeric digits for this bar code (the 8th digit checksum 
will be automatically calculated). In the editor, the bar code image for 
that data will be displayed.

5 The first digit of the UPC-E bar code must be 0 which will 
automatically insert a 0 in the first position.

To Insert Code 128 and EAN 128 Bar Codes
Do the following tasks to insert code 128 and EAN 128 bar codes:

1 Begin in Frame <02 Insert> (01 Edit > 02 Edit - Inserts > 01 Insert > 02 
Insert).

2 Press the F2 key to select <Bar Code>. Then press the F5 key two 
times. Frame <03 Barcode> appears in the display. Refer to Figure 5-
55 on page 5-62.

3 Use the arrow keys to move the cursor to the location in the message 
where you want the bar code insert to appear. 

4 You can now choose to add a bar code into the message:

• To insert a Code 128 bar code, press the F1 key to select <Insert 
Code 128>. Enter the desired alphanumeric data for this bar code. 
In the editor display, the bar code image for that data will be 
displayed. Refer to Figure 5-57 on page 5-64.

• To insert an EAN 128 bar code, press the F2 key to select <Insert 
EAN 128>. Enter the desired alphanumeric data for this bar code. In 
the editor display, the bar code image for that data will be 
displayed. The EAN 128 bar code does not need a leading FNC1 
function code inserted. This is already included in the bar code. 

Figure 5-56: Messages with Bar Code Inserts

UPC-A Bar Code 

UPC-E Bar Code 
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5 Use the appropriate keys on the keyboard to enter the information 
that is to appear in the bar code. 

6 The user can enter in the desired data to construct the Code 128 and 
EAN 128 bar code without having to use switch codes. The printer 
automatically configures the data into the proper formats.

To Insert Graphic
Procedure describes how to insert saved graphics (created in the Frame F4 
<Build Graphic> section) into a message:

1 In the current message, set the cursor position where the graphic will 
be inserted.

2 Select Frame F4 <Insert Graphic> in Frame <02 Insert>.

3 The following message appears in the display screen:

Control Select, Insert Control, and Function Characters

When you enter a Code 128 bar code, you may use the 
<Control Select> option to include FNC1, FNC2, FNC3 
or FNC4 function code. Typically, the function codes are 
not needed for the Code 128 bar code. For the EAN 128 
bar code, the FNC1 control code is automatically added 
to the beginning of the bar code so it is not necessary for 
the user to include another.
<Insert Control> uses four special function codes, 
designated as FNC1, FNC2, FNC3, and FNC4. Their 
use is determined by the Code 128 application:

• Only FNC1 may be inserted into a Code EAN 128 
bar code.

• Before inserting the function codes, the user should 
have advanced knowledge of their functionality or 
undesired effects in the bar code may happen. 

• F3<Control Select> selects the function character. 
• F4<Insert Control> inserts the character into the 

message.

Figure 5-57: Messages with Bar Code Inserts

Code 128 Bar Code 

EAN 128 Bar Code 
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4 Use the right/left cursor keys to select up to 25 possible graphic 
names.

5 When the desired graphic name is shown, press ENTER to insert the 
graphic image into the message at the cursor location.

Note: If the desired graphic name is not shown, then the print matrix for the 
current display does not match the graphic's print matrix.

Manage System Setup

To Set up an Alternative Zero
This section explains how to change the version of the zero character in the 
display and printed message.

Procedure

1 Begin in Frame <04 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-Up > 01 System > 02 System > 03 System > 04 System - 
Locale Setup > 01 Locale > 02 Locale). Refer to Figure 5-58.

2 Press the F1 key to select <Alternate Zero>. The following message 
appears in the display screen:

Figure 5-58: Frame <01 Locale> - Alternate Zero

Alternate 
Zero
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3 Use the right or left cursors to change the zero symbol.

4 Press the ENTER key to save the selection.

To Set up a Programmable Shift Timer
This procedure explains how to insert a programmable time-based (shift 
timer) code into a message.

A programmable time-based code allows you to insert a 1 to 24 character 
alphanumeric work-shift code (A-Z, a-z, 0-9) in a printed message. This 
“code” is based on a work-shift time. You may insert up to 24 shifts, using 
26 letter choices and 24 number choices.

The computer has default shifts, codes, and times set-up for you. The 
computer's internal clock starts at midnight (00:00) and ends at 11:59 p.m. 
(23:59). The default 24-shift starting times and codes are as follows:

Table 5-17 lists the shifts and their timings.

Note: If you would like to use the default shift settings shown above for your shift 
values without making a change, go directly to the next section “To Insert the 

Shift Timer Shift Timer

Shift 1(A) 00:00  Shift 13 (M) 12:00

Shift 2(B) 01:00 Shift 14 (N) 13:00

Shift 3(C) 02:00 Shift 15 (O) 14:00

Shift 4(D) 03:00 Shift 16 (P) 15:00

Shift 5(E) 04:00 Shift 17 (Q) 16:00

Shift 6(F) 05:00 Shift 18 (R) 17:00

Shift 7 (G) 06:00 Shift 19 (S) 18:00

Shift 8 (H) 07:00 Shift 20 (T) 19:00

Shift 9 (I) 08:00 Shift 21 (U) 20:00

Shift 10 (J) 09:00 Shift 22 (V) 21:00

Shift 11 (K) 10:00 Shift 23 (W) 22:00

Shift 12 (L) 11:00 Shift 24 (X) 23:00

Table 5-17: Shift Timer
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Work-Shift Code” on page 5-42 for instructions on inserting a shift code into your 
message. It is not necessary to complete the next procedure.

Setup Procedure

Do the following tasks to modify a programmable time-based (shift timer) 
code insert from the default setting or from a previous setting:

1 Begin in Frame <03 System> (01 Edit > 02 Edit> 03 Edit > 04 Edit _ 
System Set-Up > 01 System > 02 System > 03 System). See Figure 5-59.

2 Press the F1 key to access <Shift Setup>. The Frame <01 Shift> 
appears.

3 Press the F4 key to access <Max Shifts>. This allows you to set how 
many shifts you will have. You may create up to 24 “shifts”. The 
following appears in the display screen: 

4 Enter the number of shifts you want to be available. The entry must be 
from 1-24.

5 Press the ENTER key. The number you entered appears above the F4 
key <Max. Shifts> in the display screen. 

6 Press the F1 key to access <Select Shift>. This allows you to select the 
work-shift number you want to edit. You can create up to 24 work-
shifts by number. The following appears in the display screen:

Shift
Set-Up

01
Shift

Figure 5-59:  <01 Shift> Frame 

Select
Shift

Shift
Start

Shift
Code 

Max.
Shift
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7 Enter the shift number. The entry must be from 1-24 (or whatever is 
the maximum number located above the F4 <Max Shifts>).

Note: The largest shift number allowed is dependent upon the maximum 
shifts value. If the maximum shifts value is 12, then the largest shift number 
entered can be 12.

8 Press the ENTER key. The number you entered appears above <Select 
Shift> in the display screen. 

9 Press the F2 key to access <Shift Start>. This allows you to enter the 
starting time for the work-shift. The following appears in the display 
screen:

10 Enter the starting time for the current work-shift number.

11 Press the ENTER key. The number you entered appears above <Shift 
Start> in the display screen. Frame <01 Shift> appears.

Note: Make sure that every starting time (shift) you enter is in ascending 
order. For instance, enter 0100 for shift 1, 0200 for shift 2, and 0400 for shift 
3. Do not enter irregular sequences like 0100 for shift 1, 0400 for shift 2, and 
0200 for shift 3. This rule does not apply to the shift code, which may be any 
character in any order.

12 Press the F3 key to access <Shift Code>. This allows you to enter a 
single alpha-numeric work-shift code (A-Z, a-z, or 1-24) which is 
single-character and alpha-numeric. The following appears in the 
display screen:

13 Enter the single, alphanumeric work-shift code (A-Z, a-z, or 1-24).

14 Press the ENTER key. The number or letter you entered appears 
above <Shift Code> in the display screen. Frame <01 Shift> appears.
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Manage Bar Codes

To Print Reverse Image Bar Codes
This procedure shows you how to print a reverse image bar code. This 
means that instead of printing the lines of a bar code with dark ink on a 
light-colored background, the printer will print, what was previously a 
space of the non-reversed bar code, with a line on a reversed bar code. In 
addition, what was previously a line on a non-reversed bar code, will 
appear as a space on a reversed bar code. Refer Figure 5-60 on page 5-69 
for an example of a reverse image bar code.

All bar codes that are 10x16 high or greater print matrix sizes may be 
printed in reverse images.

Note: The reverse bar code function has no effect on any type of message other 
than a bar code message.

Do the following tasks to reverse the image bar code:

1 Load the desired existing message into the printer or create a new 
message and load it into the printer.

2 Begin in Frame <06 Print> (01 Edit > 02 Edit > 03 Edit > 04 Edit - Print 
Set-Up > 01 Print > 02 Print > 03 Print > 04 Print > 05 Print > 06 Print). 
See Figure 5-61.

Figure 5-60: Reverse Image Bar Code

2 of 5I Standard Bar Code

2 of 5I Reverse Image Bar Code

Quiet 
Zones
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3 View the current setting above <Reverse Barcode>. Is it set to <ON>?

• If NO, press the F2 key to change the setting to <ON>. This will 
print the bar code in reverse image.

• If YES, the message is already sent to print the bar code in reverse 
image.

4 Press the ENTER key to return to Frame <01 Print>.

Note: The bar code symbols will not appear in reverse image in the display 
screen. However, the bar code message will be printed in reverse image.

To Define 2D Data Matrix Barcodes
The Videojet 1520 Excel supports 2D Data Matrix bar codes in matrix size 
from 10x10 to 24x24. This provides a highly condensed code for use in a 
wide range of applications where space is limited.

Inserting a 2D Data Matrix Barcode into a message is very similar to 
inserting any 1D bar code (like EAN128 or UPCA) into a message. There 
are few considerations to take into account when forming the message to 
include the bar code. First, select the minimum font height to contain the 
2D bar code.

For the 2D Data Matrix bar codes, choose the Print Matrix and Char Size.

Data Matrix Density Char Size Print Matrix

26 x 26 Double 30X34 high

32 x 32 Double 30X34 high

8 x 18 Single, Double, 
Double, Single, 
Single 

7 x 9, 9 x 12, 10 x 16, 16 x 
24, 30 x 34

8 x 32 Single, Double, 
Double, Single, 
Single 

7 x 9, 9 x 12, 10 x 16, 16 x 
24, 30 x 34

12 x 26 Double, Double, 
Double, Single 

9 x 12, 10 x 16, 16 x 24, 30 
x 34

Table 5-18: 2D Data Matrix Considerations

Figure 5-61:  <06 Print> Frame 

Reverse
Bar Code
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Do the following tasks to insert 2D Data Matrix Barcodes:

1 In <02 Edit> Frame, press F2 <Font Setup>. The <01 Font> frame 
appears. 

2 Press the F2 key until the desired Print Matrix is displayed (10x16 or 
16x24).

3 Press F1 <Char Size> until the desired Char Size is displayed.

4 In <04 Barcode> Frame (01 Edit > 02 Edit - Inserts > 01 Insert > 02 
Insert - Bar Code > 01 Barcode > 02 Barcode > 03 Barcode > 04 
Barcode), press F2 <Data Matrix Density> to select the desired Data 
Matrix Density. Refer to Figure 5-62 on page 5-72.

12 x 36 Double, Double, 
Double, Single 

9 x 12, 10 x 16, 16 x 24, 30 x 
34

16 x 36 Double, Double, 
Single 

10 x 16, 16 x 24, 30 x 34

16 x 48 Double, Double, 
Single 

10 x 16, 16 x 24, 30 x 34

10x10, 12x12, 14x14, 
and 16x16

Double 10x16 or 16x24

18x18, 20x20, 22x22, 
and 24x24

Triple 16x24

Data Matrix Density Char Size Print Matrix

Table 5-18: 2D Data Matrix Considerations
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5 Press F3 <Data Matrix Set-Up> to set the required parameters.

6 Press F1 <Insert Data Matrix> to insert Data Matrix bar code. 

7 Enter the desired data into the Data Matrix bar code.

8 To change back to standard text entry, move off of the bar code.

Manage Graphics
This section allows the operator to create and insert graphic symbols (such 
as logos or custom characters).

Figure 5-62: Datamatrix Setup
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To Create a Graphic
To create a graphic symbol, proceed as follows:

Note: Font size and character size of the graphic should be set to the desired 
values before creating the graphics.

1 Begin in Frame <02 System> (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-Up > 01 System > 02 System). Refer to Figure 5-63. 

2 Press F4 to select <Build Graphic>. The following message appears in 
the display screen:

3 Press ENTER to select a New Graphic, if a new graphic insert is 
desired. Otherwise use the right/left arrow keys to select a stored 
graphic name in this field.

4 Press ENTER to open the Graphic Editor to create and save new 
graphics or custom characters.

5 Press F1 to set the size of the graphic. Use left and right arrows to 
change the values. 

Figure 5-63: <02 System> Frame
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6 Create the graphic by controlling the cursor position using a 
combination of keys from the keypad. Refer to Table 5-20 on page 5-77 
for the key combinations and their functions.

7 Text can be typed after using the <Set Cursor> option in the                    
<01 Graphic> menu. 

8 The font size for typed text in the graphic is determined by the print 
matrix size selected in the F2 <Print Matrix> located in the <01 Font> 
frame.

9 Graphic editing tasks can be achieved by using Copy Block and Paste 
Block located in the <02 Graphic> frame. 

10 Crop the graphic to the desired size by cutting out the extra space at 
the edges (refer to “To Crop a Graphic” on page 5-75 for instructions).

11 Press the F3 <Save Graphic> in the <01 Graphic> frame to save the 
name of your graphic.

To Change a Graphic Size
After inserting the graphic, the size can be changed. To change the height 
and width of the graphic, proceed as follows:

1 Begin in <01 Graphic> and select the F1 <Set Size>. Show the graphic 
screen after set size activated.

Figure 5-64: Graphic Editor
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2 Change the height of the graphic to the required size, using the up/
down arrow keys.

3 Change the width of the graphic to the required size, using the right/
left arrow keys.

To Crop a Graphic
Cropping is the process of trimming the edges of a graphic to eliminate 
the empty space that surrounds it.

1 Select the F1<Set Size> in the <01 Graphic> frame.

2 Press ENTER to see the appearance of a frame depicting the current 
boundaries of the graphic.

Figure 5-65: Editor Attributes

Figure 5-66: Cropping Graphic 
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3 Adjust the size of the frame using a combination of controls; until 
boundaries of the graphic are as required. Refer to Table 5-19 on 
page 5-76 for the controls used and their functions.

Table 5-19 lists the key combinations and their functions used to define the 
boundary.

4 Go to F3<Save Graphic> in the <01 Graphic> frame to save the 
graphic.

To Use Block Editing Functions
Selecting a rectangular area of the graphic called the “block”, within the 
graphic editor allows you to delete the block or make a copy.

To select a block after the creation of a graphic, proceed as follows:

1 Press the F1 key to select <Set Block> in the <02 Graphic> frame.

2 Notice an outline of a block appearing in the graphic editor.

Key Combinations Functions

Adjust the frame size one dot at a 
time

Adjust the frame size ten dots at a 
time

Table 5-19: Keys to Crop Graphic

, and,

, and,,

Figure 5-67: Block Editor

Block
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3 Position and resize the outline using a series of key combinations on 
the keypad (refer to Table 5-20 for the various key combinations).

Table 5-20 lists the key combinations and their functions.

4 Press ENTER when you have completed positioning and resizing the 
block's outline.

Note: The outline rectangle disappears at this point.

This enables selecting a block, following the creation of a graphic.

To Copy and Paste a Selected Block
Do the following tasks to copy and paste the selected block

1 Select the F1<Set Block> in the <02 Graphic> frame.

2 Press ENTER to see the selected block appear in the window. 

3 Select the F2<Copy Block> in the <02 Graphic> frame.

4 Move the cursor to the desired location where you want to paste the 
contents of the selected block (the upper left hand corner of the 
graphic is pasted at the cursor location).

5 Select the F3<Paste Block> in the <02 Graphic> frame.

Key Combinations Functions

Move the right-hand edge

Move the left-hand edge

Move the top edge

Move the bottom edge

Move the whole outline by one dot at a time

Move the whole outline by ten dots at a time

Table 5-20: Key Combinations and Functions 

+ or

+ or

+ or

+ or

, and,

+ or
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6 In the Graphic Editor screen, press ENTER to paste the contents of the 
selected block in the desired location.

To Delete a Selected Block
Do the following tasks to delete a selected block:

1 Select the F1<Set Block> in the <02 Graphic> frame. See the block 
appear in the editor.

2 Select the F4<Delete Block> in the <02 Graphic> frame to clear the 
contents of the selected block.

To Create a Logo in Microsoft Paint Application

Note: Font size and character size of the graphic should be set to the desired 
values before creating the graphics.

1 Open the Microsoft Paint application. A new page opens by default.

2 Navigate to View > Zoom > Custom. The Custom Zoom (Figure 5-68) dialog 
box appears.

3 Select 800% under Zoom to. Click the OK button.

4 Navigate to View > Zoom > Show Grid to activate the grid for the page.

5 Navigate to Image > Attributes to set the size of the message. Set the 
necessary message size.The message height should not be more than 34.This 
menu allows the user to: 

a. Verify the format of the existing messages.

b. Pre-set the message size to avoid editing the image later

c. Select the color format of the image as Black and White.(See Figure 5-69 
on page 5-79)

Figure 5-68: Custom Zoom
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6 Create the required logo on the page (see Figure 5-70).

Note: If the logo size is bigger than required, navigate to Image > Stretch/
Skew. Enter the appropriate values to stretch/skew the images in vertical and 
horizontal directions (Figure 5-71). Ensure to enter equal values in 
horizontal and vertical columns.

7 Save the created logo as monochrome bitmap file in the USB.

8 Insert the USB drive into the USB port on the printer.

9  In <02 Info> Frame (01 Edit > 02 Edit > 03 Edit > 04 Edit - System 
Setup > 01 System > 02 System > 03 System > 04 System-System Info > 

Figure 5-69: Image Attributes

Figure 5-70: Logo Created on Microsoft Paint

Figure 5-71: Image stretch and skew
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01 Info > 02 Info), press F4 to select Update From USB. (See Figure 5-
72)

10 Use the left and right arrow keys to select the saved bitmap.

11 Press the Enter key. Follow the prompts. Press Esc key when the 
system is updated.

12 Navigate to <02 System> Frame (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Setup > 01 System > 02 System), and press F4 to select build 
graphic.

13 Use the left and right arrow keys to select the image.

14 Press the Enter key and the logo appears on the screen. (See Figure 5-
74)

Figure 5-72: 02 Info

Figure 5-73: 02 System
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Figure 5-74: Logo on menu screen
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6Maintenance

Introduction
The maintenance of the printer includes the procedures that an operator or 
a service technician can perform. This chapter describes the maintenance 
tasks that the operators of the printer are allowed to perform. The other 
maintenance tasks that only the trained service technicians and personnel 
must perform are described in the Service Manual.

Warning

PERSONAL INJURY. It is possible that in a fault condition, heater 
can reach 70° C. Do not touch the plate on which heater is installed. 
The failure to follow this warning can cause the personal injury.

Maintenance Schedule
Table 6-1 shows the maintenance schedule.

Interval Task

When the printer is 
commissioned or if 
the make-up 
cartridges are 
empty 

Replace the smart cartridge.
Refer “Replace Smart Cartridges” on page 6-4.

As Required Clean the following parts of the printhead:
• Deflector Plate
• Gutter

Note: Check the quality of the print before you do the 
maintenance.
Refer “Inspect the Printhead” on page 6-6, and “Clean 
the Printhead” on page 6-7.

Clean the printer cabinet.

Every 2000 Hours Replace the back filter.

Table 6-1: Maintenance Schedule 
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Preparation for Long-term Shutdown (Storage) or 
Transportation

Note: Long term Shutdown procedure should be used when the printer will not be 
used for more than 10 days.

Parts/tools Requirement

How to Prepare for Long-term Shutdown (Storage) or Transportation
Do the following tasks to prepare the printer for long-term shutdown/
transportation:

1 Perform a Clean Stop.

2 Run three nozzle flushes.

3 Remove the Nozzle Manifold, and attach the Nozzle Bypass Manifold 
(with gasket) to it. Perform Empty Core Procedure.

Note: Printhead needs to be placed over a wash station or a suitable container 
to capture any overspill.

4 After core procedure completes, run the Flush Ink Core procedure and 
follow the printer instructions.

Note: The total time to complete this process is approximately three hours. It 
will require four sets of cartridges, each cartridge set is attached for 30 to 45 
minutes. Each set, upon completion, will be half full with mixed fluids.

5 Remove the Nozzle Bypass Manifold and fix the Nozzle Manifold 
with the gasket from the print engine deck. 

The printer is now ready for storage or transportation.

Parts/Tool Quan-
tity

Part Number

Make-up Cartridges matching 
existing make-up in ink core which 
will be flushed

4 -

Empty Cartridges 6 SP399246

Nozzle Bypass Manifold (Loop 
Connector) Kit with gasket

1 399247

Table 6-2: Parts and Tools
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Note: When the ink core has been refilled with the ink removed for storage, do not 
recalibrate viscosity on re-install as the calibration data has been saved.

Note: While preparing the printer for long term shut down, for Level 3 password, 
please contact Videojet Technologies Inc. Customer Service Department at 
800.843.3610 (United States only), or contact the local Videojet Technologies Inc. 
representative for more information. Alternatively, you can visit 
www.videojet.com>Support>Videojet Password Generator.
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Replace Smart Cartridges 
There are two types of smart cartridges:

• Ink cartridge

• Make-up fluid cartridge

The user has to install the cartridges when the printer is commissioned or 
when the cartridges are empty. The type of fluid (ink or make-up fluid) is 
written on the cartridge labels.

To add or replace the cartridges, do the following tasks:

1 Open the door of the ink compartment, and keep the door in the 
position shown in the Figure 6-1.

2 If the ink and make-up fluid cartridge indicators show empty status 

, go to step 4.

3 If the ink or make-up fluid cartridge is not loaded icon appears 

, go to step 5.

1

2

Figure 6-1:  Smart Cartridges

1. Ink Cartridge
2. Make-up Fluid Cartridge
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Warning

PERSONAL INJURY. All fluids like the ink, solvent and make-up 
fluid are volatile and flammable. They must be stored and handled 
according to local regulations. Work only in areas with good 
ventilation. The cleaning solution is poisonous if taken internally. Do 
not drink. Seek medical attention immediately if ingested.

4 Pull the old ink cartridge (item 1, Figure 6-2 on page 6-5) and the old 
make-up fluid cartridge (item 2) out of the printer cabinet.

Note: Shake the ink cartridge before inserting it into the printer.

5 Insert the new ink cartridge into the ink cartridge holder by aligning 
the cartridge key with the correct holder slot (see Figure 6-3 on 
page 6-6).

a.  Make sure that the cartridge is engaged completely in the holder.

Note: Push the cartridge until the cartridge locks into the cartridge holder     
(that is till you hear a snap sound).

Figure 6-2: Pull out the Cartridges

1

2

1. Ink Cartridge
2. Make-up Fluid Cartridge
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b.  Make sure that the icon that indicates “ink cartridge not loaded” 
disappears. The icon can take some seconds to disappear.

c. Make sure that the cartridge level indicator 100% full appears 

.

6 Insert the new make-up fluid cartridge into the make-up fluid 
cartridge holder by aligning the cartridge key with the correct holder 
slot.

a. Make sure that the cartridge is engaged completely on the holder.

b. Make sure that the icon that indicates “make-up fluid cartridge not 
loaded” disappears. The icon can take some seconds to disappear. 

c. Make sure that the icon that indicates “cartridge level 100% full” 

appears .

Inspect the Printhead
Do the following tasks to inspect the printhead:

1 Stop the ink jet and wait for the printer to completely shutdown.

2 Disconnect the printer from the power supply.

3 Loosen the printhead screw (item 2, Figure 6-4 on page 6-9) and 
remove the printhead cover (item 3).

Figure 6-3:  Cartridge Holder Slot
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4 Inspect the printhead and the inside of the printhead cover for any ink 
deposits. Clean if necessary (refer “Clean the Printhead” on page 6-7).

Clean the Printhead

Warning

PERSONAL INJURY. In the event of an ink or solvent spill, leakage 
from the printer could cause a floor/slip hazard and/or fire hazard 
(particularly if the equipment is situated over flammable material 
and/or other equipment). An optional drip tray is available (Part 
Number 234407). To install, place the drip tray on surface that the 
printer is to be used. Place the printer in the centre of the drip tray. 
Ensure that the drip tray is appropriately grounded to avoid static 
build up.

Warning

VAPOUR HAZARD. Prolonged breathing of cleaning solution 
vapor can cause drowsiness and/or effects like alcoholic 
intoxication. Use only in well ventilated, open areas.

Warning

HANDLING CLEANING SOLUTION. The cleaning solution is 
irritating to the eyes and respiratory system. To prevent personal 
injury when handling this substance:

Always wear protective rubber gloves and clothing.

Always wear goggles with side-shields or a face mask. It is also 
advisable to wear safety glasses when carrying out maintenance.

Apply barrier hand cream before handling ink.

If cleaning solution contaminates the skin, rinse off with running 
water for at least 15 minutes.
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Warning

FIRE AND HEALTH HAZARD. The cleaning solution is volatile 
and flammable. It must be stored and handled in accordance with 
local regulations.

Do not smoke or use a naked flame in the vicinity of the cleaning 
solution.

Immediately after use remove any tissues or cloth that are saturated 
with cleaning solution. Dispose off all such items in accordance with 
local regulations.

Caution

EQUIPMENT DAMAGE. To prevent the damage to the printer 
components, use only soft brushes and lint free cloths to clean the 
printer. Do not use high-pressure air, cotton waste or abrasive 
materials.

Caution

EQUIPMENT DAMAGE. Make sure that the cleaning solution is 
compatible with the ink used before you clean the printhead. The 
failure to follow the caution can damage the printer.

Note: Make sure that the jet is turned off.
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1 Put the printhead into the wash station (part number 399085).

2 Use a cleaning agent and a tissue or a soft brush to clean the following 
parts of the printhead:

• Gutter Sensing Tube (item 6, Figure 6-4)

• Charge electrode (item 7)

• Deflector plate (item 5) (see “Clean the Deflector Plate” on 
page 6-10)

• Nozzle (item 4)

Note: The cleaning agent must be compatible with the type of ink that you 
use in the printer.

3 Allow the printhead to dry and make sure that the slot in the charge 
electrode is free of cleaning agent.

Note: Use a hand blower or compressed air to dry the printhead quickly. The 
air pressure must not be more than 20 psi.

1 

2 
3 

4 
5 

6 

7 
8 

9 

1. Umbilical
2. Printhead Screw
3. Printhead Cover
4. Nozzle
5. Deflector Plate

6. Gutter Sensing Tube
7. Charge Electrode
8. Printhead Engine
9. Printhead Valve Module

Figure 6-4: Printhead 
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Caution

EQUIPMENT DAMAGE. The printhead must be dry before you try 
to start the printer. The failure to follow this caution can damage the 
printhead.

4 Refit the printhead cover and tighten the knurled screw.

Clean the Deflector Plate
To prevent the deposits of ink, clean the contoured surfaces of the 
deflector plate with the solvent, and clean dry air (CDA).

Clean the Printer Cabinet
To clean the printer cabinet, do the following tasks:

Warning

PERSONAL INJURY. Airborne particles and materials are a health 
hazard. Do not use high-pressure compressed air to clean the printer 
cabinet.

1 Remove the dust from the printer with a vacuum cleaner, or soft 
brush.

Deflector Plate

Figure 6-5: Clean the Deflector Plate
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2 Clean the outer surfaces of the printer with a wet lint free cloth. 

Use a mild detergent to remove the contamination that you cannot 
remove by a wet cloth.
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7Troubleshooting

Introduction
This chapter contains the troubleshooting and fault diagnosis information 
for the everyday users of the printer.

The service manual has more information on troubleshooting for the 
service technician and trained personnel.

Warning

LETHAL VOLTAGES. Lethal voltages are present within this 
equipment when the equipment is connected to the main electrical 
supply. Only trained and authorised personnel must do the 
maintenance work. Observe all statutory electrical safety codes and 
practices. Unless it is necessary to run the printer, disconnect the 
printer from the main electrical supply before you remove the covers 
or do any service or repair activity. The failure to follow this 
warning can cause death or personal injury.

Warning

PERSONAL INJURY. It is possible that in a fault condition the heater 
can reach 70° C. Do not touch the plate on which heater is installed. 
The failure to follow this warning can cause the personal injury.
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The Printer Does Not Start
1 Make sure that the printer is turned on. To turn on the printer, press 

the green push button.

2 Check the system status LEDs (see Table 7-1) to see if a system fault 
has occurred or if the user interference is required.

3 If the red or amber LEDs are illuminated, inspect the display to see 
that icons and related message are displayed. Refer to “Printer Status 
Icons” on page 7-7.

4 If the green LED is illuminated, and the printer does not print:

• Make sure that the product sensor and shaft encoder are connected 
and correctly operating (a lamp found behind the product sensor 
must flash if a product passes the sensor).

• If the problem continues, report the fault to VTI @ 1-800-843-3610 
(within United States only). The customers outside the US must 
contact a Videojet subsidiary office or the local Videojet distributor.

5 If the system status LEDs do not illuminate, check the main electrical 
supply as follows:

a. Make sure that the main electrical supply is available.

b. Make sure that the main input connector is fitted correctly.

c. Make sure that the main power supply button is in the ON position 
(looks pressed in).

d. If the problem continues, report the fault to VTI @ 1-800-843-3610.

Illuminated Diagnosis

RED Any fault that prevents the printing. For example, 
jet not running, deflector plate trip.

AMBER and GREEN The printer requires user interference to prevent 
a system fault. For example, ink or make-up fluid 
low

GREEN The printer can print correctly

Table 7-1: System Status LEDs
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Incorrect Print Position
1 Make sure that the Product Delay value set in the Print Delay menu is 

correct. See “Set Print Delay” on page 4-28.

2 Make sure that there are no additional spaces at the start of the 
message. See “Manage Messages” on page 5-19.

Incorrect Print Size
1 Make sure that the set character height is correct. Refer to “To Adjust 

the Height of a Message” on page 5-25.

2 Make sure that the distance from the printhead to the product is 
correct. The character height increases and resolution decreases as the 
printhead moves away from the product.

3 Make sure that the correct font is selected in the message.

Note: Refer to Table A-6 on page A-7 for information on the print height.

Product

Distance from Edge

Videojet

Figure 7-1: Print Position

Distance

Figure 7-2: Distance from Product
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4 If the message width appears stretched, decrease the width value set 
in the Message Parameters menu. Refer to “To Adjust the Width of a 
Message” on page 5-26.

5 If the message width appears compressed, increase the Width value 
set in the Message Parameters menu.

Print Not Complete
1 Make sure that the Max Printed Dots value set in the Message 

Parameters menu is equal to the maximum number of dots required for 
a raster/ stroke (depends on the model). Refer to Appendix A, 
“Specifications” for more information on the different models of the 
printer.

2 You must check for any ink deposits on the printhead and clean the 
printhead if necessary. Refer to “Clean the Printhead” on page 6-7. 

Poor Print Quality
The example on the left shows good 
overall character formation, no stray 
drops and an even application of 

print.

Table 7-2 describes the samples of bad printing, their causes and the steps 
required to correct the fault.

Sample and Cause Remedy

Jet not aligned correctly, or nozzle has 
a partial block. Note bottom drops 
clipping the edge of the gutter. 
Possible EHT too low.

Clean the printhead. Perform the 
nozzle flush procedure, wash the 
nozzle with wash down. Make sure 
that the gutter is clean. 

Phasing error. The correct placement 
of drop is not good. You see a good 
amount of splashing in the area 
around.

Clean and completely dry the 
printhead. Make sure there is enough 
time available between prints to 
phase.

Table 7-2: Samples of Bad Printing 
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Alarms Screen
Do the following tasks to view the current alarms:

Incorrect modulation, too many 
satellites, charging process not 
correct.

Backflush nozzle and check for 
correct breakup.

Pressure too high, drops not deflected 
correctly, drops “run in” to one 
another, small print.

Check for jet alignment. Refer to the 
service manual for more information.

Pressure too low, the drops are over-
deflected or incorrectly positioned. 
Possible loss of most deflected drops.

Check for jet alignment. Refer to the 
service manual for more information.

Printhead too far from the substrate. 
The drops are affected by air currents 
and are spaced too far apart vertically.

Decrease the distance from the 
substrate, or select a more correct 
font.

The Printhead slot not vertical to the 
substrate travel.

The face of the of the printhead must 
be at 90 degrees angle to the surface 
of the substrate and the slot must be 
vertical to the substrate movement. 
Refer to the figure below.

Sample and Cause Remedy

Table 7-2: Samples of Bad Printing (Continued)

View A View A
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1 Begin in <02 Screens> frame (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-Up > 01 System > 02 System > 03 System - Status Screens> 
01 Screens).

2 Press the F4 key. The following message appears.

3 Move the cursor to view the other option.

Warnings Screen
Do the following tasks to view the current warnings:

1 Begin in <02 Screens> frame (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-Up > 01 System > 02 System > 03 System - Status Screens> 
01 Screens > 02 Screens).

2 Press the F1 key. The following message appears.

3  Move the cursor to view the other options.

Figure 7-3: Current Alarms Screen

Figure 7-4: Current Warnings Screen
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Printer Status Icons
The printer status icons are divided into three groups:

• The indicator icons. The indicator icons show the status of the ink jet.

• The fault (alarm) icons. When a fault condition occurs, the prints stops 
printing.

• The warning icons. When a warning condition occurs, the printer 
continues to print until the warning condition becomes a fault 
condition.

Indicator Icons

Fault (Alarm) Icons

Icon Name Description

Jet Running The ink jet is running and the machine is 
ready to print. When the machine starts, the 
icon flashes.

Jet Stopped Indicates that the ink jet is stopped.

Table 7-3: Indicator Icons

Icon Name Remedial Action

EHT Trip The deflector plate arcing is sensed. 
Clean the deflector electrodes, within the 
printhead. If this action does not correct 
the fault, contact Videojet maintenance 
engineer.

Gutter Fault Ink is not entering the gutter. Back flush 
the nozzle. If this action does not correct 
the fault, report the fault to Videojet 
maintenance engineer.

Table 7-4: Fault (Alarm) Icons 
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Ink Core Empty Check whether the ink and make-up 
cartridges are empty. If the cartridge is 
empty, then replace it and the ink core is 
refilled. Check the remaining ink core life. 
If this action does not correct the fault, 
report the fault to Videojet maintenance 
engineer.

Pump Fault Report the fault to Videojet maintenance 
engineer.

Cabinet  Too Hot The printer cabinet temperature is more 
than 80 degrees Celsius. To prevent any 
damage, the printer stops automatically. 
The printer starts after the temperature 
decreases. 
Report all overheating incidents to 
Videojet maintenance engineer.

Ink System Service 
Overdue

The ink core module is in use for more 
than 9000 hours and requires 
maintenance. Refer Table 7-6 on 
page 7-13 for ink core life.Contact 
Videojet maintenance engineer. 

- Unable to control 
viscosity

Check whether the make-up cartridge is 
not empty. If the cartridge is empty, then 
replace it. If this action does not correct 
the fault, report the fault to Videojet 
maintenance engineer.

- Mod Driver Chip 
Over Temperature

Mod amplifier hardware shutdown 
because of amplifier over temperature. 
Contact Videojet maintenance engineer.

Rasters Memory 
Overflow Detected

Contact Videojet maintenance engineer.

Valve Error Hardware error in valve hit / hold drive 
circuit. Contact Videojet maintenance 
engineer. 

- Bad Phasing Phase data cannot be obtained during 
startup. Contact Videojet maintenance 
engineer. 

- Modulation 
Readback Failed

Hardware error. Contact Videojet 
maintenance engineer. 

Icon Name Remedial Action

Table 7-4: Fault (Alarm) Icons (Continued)
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Warning Icons

- Pump Fault Pump near max RPM and pressure low. 
Contact Videojet maintenance engineer.

Ink Core Expired The ink core has expired and needs to be 
replaced.

Icon Name Remedial Action

Head Temp Too 
High

The measured printhead temperature is 
more than 3° Celsius above the target 
temperature. Contact Videojet 
maintenance engineer.

Incorrect Raster or 
Raster Family 
Name

Requested raster table not loaded into 
system. Contact Videojet maintenance 
engineer.

Head Temp Too 
Low

The measured printhead temperature is 
more than 3° Celsius below the target 
temperature. Contact Videojet 
maintenance engineer.

- TOF Too High The measured jet velocity is more than 
10% above the target velocity. Contact 
Videojet maintenance engineer.

- TOF Too Low The measured jet velocity is more than 
10% below the target jet velocity. 
Contact Videojet maintenance engineer.

- No Signal Fault 
Shutdown

The warning is disabled by entering 
Service mode and enabled by leaving 
Service mode.

Printhead Cover 
Open

The printhead cover is not closed 
correctly. The printer continues to run but 
will not print. If this icon appears when 
the printhead cover is closed correctly, 
report the fault to a maintenance 
engineer

Phase Threshold 
Error

The printer is unable to acquire a phase 
profile with the phase threshold set to the 
minimum value. Contact Videojet 
maintenance engineer.

Table 7-5: Warning Icons 

Icon Name Remedial Action

Table 7-4: Fault (Alarm) Icons (Continued)
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Ink Viscosity Too 
High

Pressure setpoint for correct velocity is 
greater than calculated pressure by > 0.1 
bar. Contact Videojet maintenance 
engineer.

Ink Viscosity Too 
Low

Pressure setpoint for correct velocity is 
less than calculated pressure by > 0.1 
bar. Contact Videojet maintenance 
engineer.

Pressure Too High The actual pressure is > 0.2 bar above 
the target pressure. Contact Videojet 
maintenance engineer.

Pressure Too Low The actual pressure is > 0.2 bar below 
the target pressure. Contact Videojet 
maintenance engineer.

No Ink Cartridge No ink cartridge present. Insert a new ink 
cartridge.

Wrong Ink 
Cartridge

The cartridge inserted into the ink 
cartridge holder contains the wrong ink 
type. Fluid REF and fluid TYPE must 
match ink core module specifications.

- Ink Cartridge 
Expired

Ink past expiry date. Insert a new ink 
cartridge.

Ink Cartridge 
Removed

Ink cartridge smartchip data reads no 
cartridge present. Refit an empty ink 
cartridge.

- Ink Insertions 
Exceeded

The current ink cartridge inserted more 
than ten times. Insert a new ink 
cartridge.

No Make-up 
Cartridge

No make-up fluid available for addition to 
the ink core module. Insert a new make-
up cartridge.

Wrong Make-up 
Cartridge

The cartridge inserted into the make-up 
fluid cartridge holder contains the wrong 
make-up fluid type. Insert a new make-
up cartridge.

Icon Name Remedial Action

Table 7-5: Warning Icons (Continued)
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Make-up cartridge 
low

Insert a new make-up fluid cartridge. The 
part number of the make-up fluid is 
displayed also. If the icon flashes after 
replenishment, contact a maintenance 
engineer.

- Head Start / Stop 
Inhibited

Viscosity is too low, so Head Start / Stop 
is inhibited to prevent solvent addition. 
Contact Videojet maintenance engineer.

- Makeup Insertions 
Exceeded

The current make-up cartridge is 
inserted more than ten times. Insert a 
new make-up cartridge.

Ink Core Level High Ink level in the ink core module is very 
high. The icon must not be illuminated 
after a short interval of time. If the icon is 
displayed for more than 5 minutes, 
report the fault to a maintenance 
engineer. Refer to the service manual for 
more information.

Ink Core Level Low Check whether the ink cartridge is 
empty. If an empty ink cartridge is 
replaced with a full cartridge while the jet 
is running, the printer will automatically 
top-up the core.

Cabinet Hot Electronics compartment is above 70 
degrees Celsius. Contact Videojet 
maintenance engineer.

- Ink Core Insertions 
Exceeded

The ink core module has been 
disconnected / reconnected more than 
ten times. Insert a new ink core module.

Pump RPM Near 
Max

Pump RPM setpoint greater than 98% to 
achieve set pressure. Contact Videojet 
maintenance engineer.

No Ink Core No data from ink core module smartchip 
- ink core module not plugged in. Contact 
Videojet maintenance engineer.

Ink Core Service 
Soon (0.5% left)

Ink core module nearing end of service 
life.
0.5% left. Refer Table 7-6 on page 7-13. 
Contact Videojet maintenance engineer.

Icon Name Remedial Action

Table 7-5: Warning Icons (Continued)
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Ink Core Service 
Soon (2% left)

Ink core module nearing end of service 
life.
2% left. Refer Table 7-6 on page 7-13. 
Contact Videojet maintenance engineer.

Ink core service 
soon (5% left)

Ink core module nearing end of service 
life.
5% left. Refer Table 7-6 on page 7-13. 
Contact Videojet maintenance engineer.

Ink core service 
soon (10 % left)

Ink core module nearing end of service 
life.
10% left. Refer Table 7-6 on page 7-13. 
Contact Videojet maintenance engineer.

Product Delay Too 
Short

Contact Videojet maintenance engineer. 

Inter-print Gap Too 
Short

Insufficient time to compile between 
prints. Contact Videojet maintenance 
engineer. 

Print Queue Too 
Deep

Too many products between PEC and 
the printhead. Contact Videojet 
maintenance engineer. 

Print Overlap Print starts before end of current print. 
Contact Videojet maintenance engineer. 

No Time to Phase Contact Videojet maintenance engineer. 

No time for TOF The printer is unable to get an “actual 
velocity” and thus cannot perform TOF 
velocity control. 

Overspeed The Shaft encoder speed is very high to 
get the print width that you need. If the 
print width is not acceptable, report the 
fault to a maintenance engineer. 

Icon Name Remedial Action

Table 7-5: Warning Icons (Continued)
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Ink Core Life

- Maximum Print 
Rate Exceeded

Contact Videojet maintenance engineer.

- No Valid Ink 
Parameters

Contact Videojet maintenance engineer.

- Possible Ink 
Coefficient Update 

Ink cartridge coefficients do not match 
ink core module coefficients. Contact 
Videojet maintenance engineer.

USB Connection Is 
Over Current

External USB device requesting 
excessive current. Contact Videojet 
maintenance engineer.

- Suspected Head 
Heater Failure

 Contact Videojet maintenance engineer.

- Creating Raster 
Catalog

Software busy. Raster being replaced. 
Cannot print. Contact Videojet 
maintenance engineer.

- Bad Nozzle!!!
Please Replace Or 
Repair

Contact Videojet maintenance engineer.

- Tank Not Filling Ink core module still LOW after 5 
attempts to add ink to increase level. 
Contact Videojet maintenance engineer.

DAC Overflow  hardware fault. Contact Videojet 
maintenance engineer.

DAC Comms Error  hardware fault. Contact Videojet 
maintenance engineer.

Yellow Beacon 
Indicator

Message prompts user to refit cartridge.

Videojet 1520 12000 Hours

Table 7-6: Ink Core Life

Icon Name Remedial Action

Table 7-5: Warning Icons (Continued)
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Fault Messages
Fault messages are displayed at the bottom left of the screen to 
supplement the printer fault icons. The messages are arranged so that, if 
more than one fault is found, only the most serious fault message is 
displayed.

Diagnostics Screen
The diagnostic screens show the current value of different parameters 
which help you in troubleshooting the printer. 

Do the following tasks to view the diagnostic screens:

1 Begin in <01 Screens> Frame (01 Edit > 02 Edit > 03 Edit > 04 Edit - 
System Set-Up > 01 System > 02 System > 03 System - Status Screens > 
01 Screens).

2 Press F1, F2 and F3 keys to view the Diagnos Screen1, Diagnos 
Screen2, Diagnos Screen3 parameters respectively. 

Note: Diagnostic Screens can also be accessed from the <Service 01> frame. 
You can toggle between the Diagnostic Screen 1, Diagnostic Screen 2, 
Diagnostic Screen 3 and Alarm Screen by pressing Ctrl+S.

Figure 7-5: Diagnostic Screen1 Parameters
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Figure 7-6: Diagnostic Screen2 Parameters

Figure 7-7: Diagnos Screen3 Parameters



Rev AA Electrical Specifications     A-1

ASpecifications

Electrical Specifications
The electrical specifications of the printer are shown in Table A-1.

Weight
The dry weight specification of the printer is shown in Table A-2.

Voltage 100 V AC to 240 V AC

Frequency 50 Hz to 60 Hz

Power Consumption 120 watts Maximum

Table A-1: Electrical Specifications

Dry weight 18 kg

Table A-2: Weight Specifications
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Dimensions
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Figure A-1: Printer Dimensions (Videojet 1520)
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The dimensions of the printer are shown in Table A-3.

Cabinet   Width 345 mm

Height 533 mm

Depth 338 mm

Table A-3: Printer Dimensions  

565.8 mm
(22.27 inches)

39°

21
8.

3 
m

m
(8

.6
 in

ch
es

)

387.58 mm
(12.25 inches)

271 mm

250.2 mm

210.2 mm

(10.66 inches)

(9.85 inches)

41.25 mm
(1.62 inches)

(8.28 inches)
Ø 

21
.2

 m
m

(0
.8

3 
in

ch
es

)

Ø

Figure A-2: Printer Dimensions (Videojet 1520) (continued)
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Printhead
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Optional Accessories

Mobile Printer Stand

Printhead Diameter ∅41.3

Diameter of the nozzle orifice 60//70 
Microns 

Umbilical length 1520
3 Meter Standard
6 Meter Optional

-

Cabinet 
Variations

Standard IP55 
Optional IP65 (1520 Only)

-

Table A-3: Printer Dimensions  (Continued)
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Figure A-3: Mobile Printer Stand
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Static Printer Stand
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Figure A-4: Static Printer Stand
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Printhead Stand

Environmental Specifications
The environmental specifications of the printer are shown in Table A-4

Operating temperature 5 ºC to 45 ºC (41 ºF to 113 ºF)*

Rate of change of ambient 
temperature

10 ºC (18 º F) per hour maximum

Relative humidity 0% to 90 % non-condensing*

Storage temperature 5 ºC to 50 ºC (41ºF to 122 ºF) in original 
packaging

Industrial-protection rating IP55 is standard for Videojet 1520 
Excel.IP65 is optional for Videojet 1520 
Excel

Table A-4: Environmental Specifications
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Figure A-5: Printhead Stand
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*Note: When the printer is operated in an environment with elevated humidity, 
or with certain inks (including water sensitive inks), air dryers or other items may 
be required. Please contact Videojet Technologies Inc. customer service 
department at 800.843.3610 (United States only), or contact the local Videojet 
Technologies Inc. for more information.

Ink and Make-up Fluid Capacity
The ink and solvent capacity of the printer are shown in Table A-5.

Print Height
The minimum and maximum height of the message for the print matrix is 
shown in Table A-6.

Font Specifications and Line Speeds
The font specifications and the line speeds for 60 and 70 micron nozzle are 
shown in Table A-7.

Note: The optimum value is 11mm. The range is 5 to 15 mm.

Note: The line speeds listed in the Table A-7 and Table A-8 are for 60 dpi only.

Ink Cartridge 750 milliliters

Make-up Fluid 
Cartridge

750 milliliters

Table A-5: Ink and Make-up Fluid Capacity

2 mm Minimum

12 mm Maximum

Table A-6: Print Height
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Barcode Specifications
The available barcode types are shown in Table A-8.

Line
Mode

Height Width Cal Speeds

70 Micron 60 Micron

ft/min m/min ft/min m/min

1 5 5 914 279 914 279

1 7 4 960 293 960 293

1 7 5 800 244 800 244

1 9 7 356 108 356 108

1 12 9 256 78 256 78

1 16 10 200 61 194 59

1 24 16 96 29 96 29

1 34 25 53 16 56 17

2 5 5 256 78 256 78

2 7 4 240 73 320 98

2 7 5 200 61 267 81

2 9 7 119 36 125 38

2 12 9 85 26 85 26

2 16 10 53 16 56 17

3 5 5 119 36 125 38

3 7 4 108 33 108 33

3 7 5 90 27 90 27

3 9 7 53 16 56 17

4 5 5 85 26 85 26

4 7 4 64 20 67 20

4 7 5 53 16 56 17

5 5 5 53 16 56 17

Table A-7: Line Speeds 
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Note: Barcode specification and Data Matrix are listed in the Table A-8 and 
Table A-9. Barcodes run at single line speed based on height selected at 60 dpi.

Barcode Type

UPCA

UPCE

EAN8

EAN13

Code 128 (A, B and C)

UCC/EAN 128

2 of 5I

Code 39

2D Data Matrix

2D Data Matrix 
rectangular (*GS1)

Table A-8: Barcodes Matrix 

Data Matrix

10 x 10

12 x 12

14 x 14

16 x 16

18 x 18

20 x 20

22 x 22

24 x 24

26 x 26

32 x 32

8 x 18

8 x 32

Table A-9: Data Matrix Code Sizes 
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Note: The 60 Micron Nozzle is recommended to print datamatrix codes at 16 
high or taller.

12 x 26

12 x 36

16 x 36

16 x 48

Data Matrix

Table A-9: Data Matrix Code Sizes (Continued)
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BSoftware Summary 
Chart

Introduction
Software Summary describes the navigational steps to access the different 
frames in the Videojet 1520 Excel User Interface.
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Index
Numerics

2D Data Matrix 5-70
5 x 7 SL Tower 5-69

A
Alarms Screen 7-5
Alpha Hour Insert 5-42
Alpha Month Insert 5-46
Alternative Zero 5-65
Auto Encoder 4-16
Auto Print 4-10
Auto Repeat 4-25

B
Bar Code 5-59

3 of 9 or 2 of 5 Bar Codes 5-60
Code 128 and EAN 128 Bar Codes 

5-63
EAN-8 and EAN-13 Bar Codes 5-

61
UPC-A and UPC-E Bar Codes 5-

62
Bar Code Types 5-59
Baud Rate 4-24
Block Editing Function 5-76

C
Cabinet

Cleaning 6-10
Dimensions A-3

Cabinet Too Hot Icon 7-8
Character Set-up Mode 5-6
Connector Panel 3-8
Contact Information 0-iv
Control Panel

Function Keys 3-3
Crop Graphic 5-75
Customer Training 0-v

D
Day of Month Insert 5-45
Display 3-3

E
Edit Mode 5-5
EHT Block

Cleaning 6-10
Expiration Alpha Month Insert 5-52
Expiration day of month insert 5-47
Expiration Julian Date Insert 5-51
Expiration month of year insert 5-49
Expiration Year Insert 5-49

F
FIRE AND HEALTH HAZARD 6-8

G
Grounding 2-3
Gutter Fault Icon 7-7

H
HANDLING CLEANING AGENT 6-7
Head Start 4-3
Head Stop 4-3

I
Industrial-protection rating A-6
Ink

Capacity A-7
Ink Core Module 3-6
INK OFF 4-3
INK ON 4-3
Insert Mode 5-6
Insert Timer 5-54

J
Jet Running Icon 7-7
Jet Stopped Icon 7-7
Julian Date Insert 5-46

K
Keypad 3-3

M
Mixer Tank Empty Icon 7-8
Multi-Stroke 5-15

N
Nozzle Flush 4-7



Videojet 1520 Excel Operator Manual

Index-2     Rev AA

P
Print Height A-7
Print Matrix 5-21
Print Set-up Mode 5-14
Print Size Incorrect 7-3
Print Speed A-7
Printer Setup 4-8
Printer Status Icons 7-7

Fault (Alarm) Icons 7-7
Indicator Icons 7-7
Warning Icons 7-9

Printhead 3-7
Theory of Operation A-7

Printhead Cover Open Icon 7-9

R
Recall Message 5-24
Reduction Factor 4-17
Remote Data Insert 5-57
Reverse Barcode 5-70

S
Safety 2-1

Compressed Air Safety Guide-
lines 2-8

Electrical Safety Guidelines 2-2
Fluid Safety Guidelines 2-5
UI Related Safety Guidelines 2-8

Serializer Insert 5-54
Service Mode 5-9
Service Program 0-iv
Service Status 4-27
Set Language 4-8
Set Print Delay 4-28
Set Print Set-up Parameters 4-30
Set the Product Detector

Active Level 4-14
Internal Distance 4-13

Smart Chip Data 4-25
Specifications A-1

Barcode A-8
Electrical A-1
Font A-7
Weight A-1

Store Message 5-23
System Backup 4-32
System Clone 4-33

System Restore 4-32
System Status LEDs 7-2
System Upgrade 4-34

T
Throw Distance 4-10
Top Up Out Icon 7-11
Training 0-v
Troubleshooting 7-1–7-14

Incorrect Print Position 7-3
Poor Print Quality 7-4
Print Not Complete 7-4
Print Size Incorrect 7-3

V
VAPOUR HAZARD 6-7
View Stored Messages 5-24

W
Warnings Screen 7-6

Y
year insert 5-45
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